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time period, contact StarBase Corporation 
for a full refund less shipping and handling.
StarBase Corporation warrants that the pro-
gram will perform in substantial compliance 
with the online and written documentation 
supplied with the software product. If a sig-
nificant defect in the product is found, the 
Purchaser may obtain a refund. In no event 
will such a refund exceed the purchase price 
of the product, exclusive of freight charges.
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A PARTICULAR PURPOSE, WITH 
RESPECT TO THE PRODUCT. SHOULD 
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INCIDENTAL OR CONSEQUENTIAL 
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BASE CORPORATION BE LIABLE FOR 
ANY DAMAGES WHATSOEVER 
(INCLUDING WITHOUT LIMITATION, 
DAMAGES FOR LOSS OF BUSINESS 
PROFITS, BUSINESS INTERRUPTION, 
LOSS OF BUSINESS INFORMATION AND 
THE LIKE) ARISING OUT OF THE USE OR 
THE INABILITY TO USE THIS PRODUCT 
EVEN IF STARBASE CORPORATION HAS 
BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.
Use of this product for any period of time 
constitutes your acceptance of this agree-
ment and subjects you to its contents.
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Preface
Use the installation card to install Versions on your workstation. This manual contain
information you need to use Versions. Versions can be integrated with StarTeam pro
ucts. Evaluation copies of the StarTeam products are also included on the CD-ROM

What’s on the CD-ROM

The Versions CD-ROM contains the following:

\Versions The files necessary to install Versions onto your system.

\StarTeam Pro The files necessary to install an evaluation copy of StarTeam 
Workstation Professional onto your system.

\StarTeam The files necessary to install an evaluation copy of StarTeam 
Workstation onto your system.

\Server The files necessary to install an evaluation copy of StarTeam 
Server, which provides client/server WAN access to StarTeam 
projects.

\WConnect The files necessary to install an evaluation copy of StarTeam W
Connect, which makes it possible to connect to StarTeam proje
via an Internet web browser.
Preface ix
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\Tutor The Versions and StarTeam Walkie-Talkies, a series of .avi files
that introduce you to the respective Workstation interfaces and 
functionality. These .avi files are not automatically installed onto
your system and require a sound card.

\Acrobat The files necessary to install the Acrobat Reader on your system
The Acrobat reader allows you to read the .pdf files in \Docs.

\Docs Online versions of this manual and the manuals for StarTeam 
Workstation, StarTeam Server, StarTeam Web Connect, and So
ware Configuration Management Overview which can be read 
using the Acrobat Reader. The online version of this manual is 
named Versions.pdf.

As part of the installation for Versions, you can install the StarDraw Sample Applica-
tion that contains the StarDraw sample application files.

Most of the directories mentioned here have a readme.wri file. The readme.wri in the
directory gives an overview of the StarBase products.

Accessing Electronic Manuals

You have access to the Versions User’s Guide in electronic form. This is in addition to the
context sensitive help automatically installed with Versions and available from the H
menu.

If you do not want to install the online documentation, you can still access it on the V
sions CD-ROM. In the \Docs directory are:

versions.pdf Versions User’s Guide

starteam.pdf StarTeam Workstation User’s Guide

server.pdf StarTeam Server User’s Guide
x Versions User’s Guide



table 
do 

 

ess 

utori-
D-
wconnect.pdf StarTeam Web Connect User’s Guide

scm.pdf StarTeam Configuration Management Overview

Because the online manual for Versions and StarTeam Workstation is in Adobe Por
Document Format (.pdf), you must have the Adobe Acrobat Reader installed. If you 
not already have Adobe Acrobat Reader installed, follow these instructions:

1.  With the Versions CD loaded, run:

x:\acrobat\ar32e30.exe

where x: is the drive letter of your CD-ROM drive.

This program allows you to read .pdf files.

(This directory also contains a ReadMe file that gives more details regarding the
Adobe Acrobat Reader.)

2.  Follow the on-screen instructions to finish the Acrobat Reader installation.

When installed, the Acrobat Reader is associated with .pdf files, allowing you to acc
the electronic copies of the Versions and StarTeam users guides. 

Video Tutorials

The Versions CD-ROM includes a video tutorial to teach your team about Versions. 
However, listening to the tutorials requires a multi-media sound card. To run these t
als, click View Tutorials in the master setup program (\setup.exe on your Versions C
ROM). Then click the name of a tutorial.
Preface xi
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StarDraw Sample Project

The Versions CD-ROM also includes a sample Versions project, called StarDraw, th
complete and ready to use. It contains a Visual C++ sample application and related 
rials. 

The StarDraw sample project is installed on your hard drive as part of the Typical ins
tion. To use this project, double-click on the StarDraw Sample Project icon. Log in 
using the name NAllis, and take a test drive.

Online Help

For a quick explanation about setting up a project, adding files, checking files in and
etc., please see the online help file versions.hlp. Select the Contents tab, double-clic
Versions then Quick Start .

A Special Note for PVCS Users

The PVCS Import utility installed with Versions works and was tested with projects c
ated using the 32-bit version of PVCS 5.2.1. PVCS Import relies on your workstation
having a valid copy of PVCS Version Manager installed. If you encounter errors whi
running PVCS Import, make sure you can successfully run PVCS Version Manager 
that the PVCS Version Manager directory is in your workstation’s PATH. See Chapt
14, “Importing Projects from PVCS” for more information. 
xii Versions User’s Guide
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Conventions

Convention Meaning

Select File Ö Run... Menu selections will look like this. The arrow ( Ö ) indicates a 
drop-down menu selection. In this case, select File from the
menu bar, then select Run... from the drop-down menu.

  NOTE Note indicates important or supplemental information.

  TIP Tip indicates suggestions that may be helpful.

Fixed-Space Type Information that you need to type and messages from the sy
tem are displayed in fixed-space type.

                                           Icon that identifies an administrative function.

What’s New in Release 2.0a?

Versions offers several new features:

Subproject branching Enhanced subproject branching and merging enabl
recursive branching using either the latest version, 
version label or date designation. See Chapter 3, 
“Managing Subprojects.” 

MRG Command The merge command’s new /is command-line optio
allows you to include subdirectory merges with par
ticular subprojects and all of its children. See Chapt
3, “Managing Subprojects” and Chapter 13, “Using 
the Command-line Interface.” 
Preface xiii
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Mandatory check-in This administrative feature forces a check-in reaso
for file changes and keeps team member up to date
why a file changed. Maximum check-in reason lengt
was also raised from 255 characters to 20K to main
tain a more detailed file change history. See Chapt
2, “Managing Projects.” 

$Log$ keyword Lines expanded using the $Log$ keyword can be p
fixed with comment characters appropriate to file 
type. See Chapter 4, “Managing Files.”
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Chapter 1
Introducing Versions
Versions facilitates team collaboration through the use of tightly integrated compone
commonly used during product development: version control, defect tracking, and 
threaded conversations. In addition, it provides an audit log of the actions performed
project components and information about the team members performing those acti
This combination:

• Allows you to store everything related to a project in one place using just one app
tion. 

• Allows you to access information and collaborate via LAN.

• Improves teamwork on a project. 

• Saves maintenance time and makes testing easier because of the tight integrati
between version control and defect tracking.

• Keeps track of who did what and when. For example, when the audit log shows 
someone checked in a file that was later determined to have a regression, you c
undo the problem by checking out the previous version.

• Is targeted for Windows 95 and Windows NT
Introducing Versions 1-1
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Using Version Control

If you think that you have never used version control, you are probably wrong. 

Maybe you used different filenames for different versions of the same document. Fo
example, you might have named a file rpt0908.doc on September 8th and changed it to 
rpt0910.doc on September 10th—just so you could keep both versions. This is version 
control. It allows you to return to the September 8th version if the changes you made 
September 10th become obsolete.

Many popular software packages maintain a single extra copy of your work in a .bak
This “backup” file contains the previously saved copy of your work so you always ha
access to the two latest versions of the file. This scheme has proven valuable to mos
people at one time or another. It allows you to recover the previous version of a file if
accidentally delete or damage the original. This, too, is version control.

If you are new to version control, this introduction gives you the basics. If you are not 
to version control, it explains what features Versions offers and how they are 
implemented.

Versions allows you to maintain any number of previous versions in a special directo
called the vault. As far as you are concerned, the file has only one name. However, 
Versions gives each copy a unique name and keeps track of these unique names fo
The vault is a directory on your hard drive or, more likely, a network drive. Other than
being sure never to delete the directory or any file in it, the vault is of no concern to y

Organizing the Project Hierarchy

Versions provides more than just version control of individual files. It allows you to 
organize entire groups of related files—files for source code, documentation, market
materials, pricing spreadsheets, and so forth. 

Versions provides a project window that displays the files in a hierarchy. Usually the
project administrator creates subprojects for a project. Then you and other users cre
files to add to those subprojects. These form a tree consisting of the root subproject,
1-2 Versions User’s Guide
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subprojects, and the files in those subprojects. You select a file from the project tree 
you want to view the file’s history, which lists the versions of that file currently stored
the vault. 

The following figure represents the StarDraw project. The open folder at the top is th
root subproject. The folders within it, such as those named Beta Materials and Desig
Documents, are subprojects. The page icons (in front of IPFRAME.CPP and 
IPFRAME.H) represent individual files. 

Adding a file puts the initial copy of that file in the vault. That copy can be checked o
from the vault by people who need to read it or change it. Before you check out a file
change it, you should lock it. A special icon indicates whether a file is locked. When 
others see that icon, they know that someone is working on the file and they should 
work on it themselves until is becomes unlocked.

  NOTE
Versions has a merge feature, but it is always best to work only on files that you 
personally have locked.

Using Working Files

When you check out a file, Versions copies the desired version of that file from the v
to your workstation's hard drive. This is called the working file and has the filename 
appears in the project hierarchy. 
Introducing Versions 1-3
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To make working files easy to locate, Versions allows administrators to specify directo
to store working files on every user's hard drive. The project itself and each subprojec
such a directory, called its default working directory. Often the working directories for
hierarchy similar to the project hierarchy. For example, the following figure compares
StarDraw project hierarchy (in a Versions project window) with its folder/directory 
structure on your hard drive (in an Explorer window). 

Notice that these hierarchies are almost identical. The Beta Materials subproject ma
the Beta Materials directory, and the Design Documents subproject maps to the Des
Documents directory. Notice the differences: The External Resources subproject ma
the res directory, and the On-line Help subproject maps to the hlp directory. In this c
the only difference is that more descriptive names are given to the subprojects than to
corresponding working directories. Also, because both subprojects and directories a
alphabetical order, the order for External Resources and On-line Help is different tha
order for the hlp and res directories.

However, a project hierarchy does not have to map so nicely onto the hard drive. Fo
example, the Source Code subproject could map to C:\Source Code while the Beta 
Materials subproject could map to C:\External Testing\StarDraw Beta\Beta Materials

In addition, Versions allows you to specify working directories on a per workstation ba
Depending on what options are set for the project, you can tell Versions to ignore the
default working directory and put files from the Beta Materials subproject in C:\StarD
Beta on the workstation in your office and in D:\Beta Materials on your laptop.
1-4 Versions User’s Guide
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The important things to remember are that the versions are stored in the vault and c
to your hard drive. The location to which they are copied depends on the default wor
directory specified for the subproject or on the working directory you specify for that 
subproject on your workstation. You cannot change or even look at a file until a versio
it has been copied to your hard drive. 

The version you read or change is always the working file on your hard drive. This is 
it is so important not to work on files that you have 1) not locked and 2) not checked
the most recent version of. Suppose you checked out the most recent version of a fil
didn’t lock it and didn’t work on it for several days. Your working file could be two 
versions older than the most recent one. If you change it and then check it in, the ch
made by your coworkers would be missing from the most recent version and lost un
they are retrieved from the earlier versions. To protect your work and that of your 
coworkers, Versions only allows you to check in files that you have locked. It warns 
if your working file is not the most recent version.

Creating New Versions

Checking in a file adds another version of that file to the vault. You check it in (and 
perhaps unlock it for others):

• When you are done working on it.

• When you have made a significant number of changes and want to save them.

• To be sure that you can go back to the file in its current state later. (Usually befo
you make some drastic changes that you might not want to keep.) 

Even with the space-saving measures that Versions can take, the vault could becom
large if you saved every single version of each file. Therefore, Versions allows you t
limit the number of versions to be kept. For example, suppose you or your administr
decide to keep only 10 versions of a particular file. Then when the 11th version is added, 
the first (the oldest) is deleted. Because you might want to save some versions, rega
of their age, Versions allows you to mark any such versions as permanent. Permane
versions are never deleted. Nor are they counted among the 10 versions to be kept,
example. That means you keep all the permanent versions in addition to the specifie
number of non-permanent versions.
Introducing Versions 1-5
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Using Security

Versions has security features that can allow some users to perform actions that oth
cannot. Security can be implemented in any of the following ways:

• No security. Any user can perform any action, such as adding subprojects or del
files.

• Project-level security. Any user with administrator status can perform any action
Users without administrator status cannot perform actions that set project/subpro
properties or that can result in the loss of data (such as deleting files and defects
Chapter 2, “Managing Projects” for more details.

• A combination of project-level and subproject-level security.

An administrator can create security templates that define sets of actions to be 
performed. Then users or groups of users can be allowed to perform the actions
defined by the template on a subproject-by-subproject basis. Suppose there are
different security templates names Power User and Guest in a project that has t
different user groups name Programmers, Testers, and Writers. For the Source 
subproject, the administrator can allow the users in the Programmers group to 
perform the actions defined by the Power Users template while the users in the 
Testers and Writers groups can perform only the actions defined by the Guest 
template. For example, the programmers can add, modify, and delete files from 
subproject, while the testers and writers can only read them. However, for the U
Manual and On-line Help subprojects, writers would have Power User privileges
while programmers and testers would have Guest Privileges. See Chapter 3, 
“Managing Subprojects” for more details.
1-6 Versions User’s Guide
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Chapter 2
Managing Projects
A project is a way to group related files and place them under version control. For ex
ple, if you create a project for software product development, the files containing the
product’s functional specification, marketing requirements document, source code, a
test suites can be stored in subprojects.

Although you may organize projects based on the file directory structure, the logical 
sions subproject hierarchy does not have to match your physical disk directory hiera

Versions makes version control easy and convenient.

• Versions keeps track of which files need to be checked in or out so that you don
have to.

• List expansion and multiple or extended selection allow you to check files in or o
from several subprojects in a single operation.

• You can use keyword expansion to embed version control information into text f
for quick and convenient reference.

• Version control is configurable. For example, when you check out a file you do n
have locked, you can require the working copy to be made read-only.

 In addition to providing version control for files, you can:

• Limit project access to specific password-protected users.

• Monitor user activity with the audit log. For example, the log indicates when any
creates or deletes a subproject, purges a file, or adds another team member.

• Quantify the accumulated data using charts and reports.

• Branch subprojects.

• Merge text file changes.
Managing Projects 2-1
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Using the Project Tree

The project tree is the hierarchical display of a Versions project and its associated su
projects and files. The project tree is always displayed in the left pane.

In the project tree shown below, StarDraw is the root subproject. It has the same nam
the project. The selected subproject is User Manual. Because User Manual is expand
files are listed beneath it in the project tree in the left pane. Because User Manual is
selected, its files are displayed in the files list in the right pane. 

In the next figure, the right pane displays the history list, a list of all the versions store
the vault for the selected file. When a file in the User Manual subproject is selected i
project tree (in the left pane), the Files tab automatically changes to the History tab, 
history list replaces the files list, and Versions disables the scope buttons and Filter d
down list box above the right pane.
2-2 Versions User’s Guide



Using the Left Pane

IconsA folder icon precedes each subproject name. An icon identi-
fying the type of file precedes file names. Clicking the name or 
the icon displays information about that item in the right pane. 
What kind of information is displayed depends on what object 
is selected from the project tree and what tab is selected from 
the right pane.

Expand and collapseYou can expand or collapse branches of the project tree:

A plus sign identifies a collapsed branch. Clicking it 
expands the branch and changes the closed folder 
icon to an open folder icon.

A minus sign identifies an expanded branch. Clicking 
it collapses the branch and changes the open folder 
icon to a closed folder icon.

Order of 
subprojects and files

When you expand a subproject, its child subprojects precede 
the list of its files. Both sets (child subprojects and files) are in 
ascending alphanumeric order. Within the tree, you can drag a 
file or subproject to a new parent subproject. For example, a 
file at the project level can be moved to one of the project’s 
subprojects. However, if security is enabled, only an adminis-
trator can move files.

Right-click for 
context menu

After selecting a subproject or a file from the project tree, use 
the Project menu or right-click to display a context menu.

Double-clickDouble-click file names in the project tree to run executable 
files or to open files in the application with which they are 
associated.

Double-click subproject names in the project tree to expand or 
collapse branches of the tree.
Managing Projects 2-3
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Using the Right Pane

One-to-many The project tree has a one-to-many relationship with the list
that appear in the right pane. For example, several files in th
right pane can be in the subproject selected from the left pa
Many audit entries in the right pane can be associated with 
file selected in the left pane. The project tree always appear
the left pane, while the files list, history list, team list, or aud
log appears in the right pane. 

Control the right 
pane

What the right pane displays depends on all of the following

• The object selected from the project tree.

• The tab selected in the right pane: Files, History, Team,
Audit. A menu, corresponding to the selected tab, 
becomes the second menu on the menu bar. For examp
if you select the Audit tab, the audit log appears in the 
right pane and the Audit menu appears on the menu ba

 

Filtering the pane • The filter selected from the Filter drop-down list above th
right pane. For example, the following figure shows the 
filter choices available when you select the Files tab. 

• The scope button selected above the right pane indicate
the depth of the project tree hierarchy for which Version
displays information in the right pane. The leftmost butto
displays the fewest entries, and the rightmost button dis
plays the most.
2-4 Versions User’s Guide



No Descendants Displays information for the 
item selected from the project 
tree only. 

Immediate Displays information for
Descendants the item selected from the 

project tree and its children 
only. 

All Descendants Displays information for the 
item selected from the project 
tree, its children, its children’s 
children, and so forth. 

As you move from one tab to another, No Descendants 
becomes the selected scope button. Versions assumes that 
initially you want to see only one level of data for the new 
tab.

Sorting• Clicking a column header sorts the displayed data based 
on the value in that column. The sort order for most col-
umns is ascending alphanumeric. To change the sort order 
from ascending to descending (or vice versa), click the 
header a second time. The primary sort’s column header 
becomes underlined. Right-click another header for a sec-
ondary sort.

Group bandsWhen sorting, group bands separate entries with the same 
value in the sort column. When the values of the sorted column 
are unique (such as a time stamp), no group bands appear.
Managing Projects 2-5
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Storing Data

The project database file stores version history and so forth. When you create a proj
you provide the project database file name (with the extension .stp) and a directory p
for this file.

Projects are accessed locally (via file server access). That means that all team mem
must have read/write, create, and delete rights to the directory containing the project
base file.

The versions of the files you place under version control go into a project vault direct
Versions uses the name of the project database file (with the extension .vlt) to create
vault directory that stores file versions for the project. The vault directory is in the sam
directory as the project database file. 

You can compress or decompress the vault files to save disk space or perhaps spee
access. See the “Compressing and Decompressing Vault Files” section in Chapter 4
more information. Do not delete or modify vault files in any way.

Using Working Directories

Each project has a working directory, a directory on your workstation from which you
read or modify the root subproject’s files. Often a root subproject has only subprojec
attached to it, but Versions still requires you to specify a working directory for the roo
subproject. You specify a project’s default working directory as you create the projec
Using the default directories for projects and subprojects means that one team mem
working on files on one workstation has the same directory structures for those files 
another team member working on another workstation. However, depending on the 
project’s options, you can designate working directories on a per workstation basis. F
example, the default working directory for the StarDraw sample project is C:\StarDra
but you might use D:\StarDraw on the workstation in your office and C:\StarDraw Sam
on your laptop.
2-6 Versions User’s Guide
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To change the working directory for the root subproject on your workstation:

1. Select the root subproject from the project tree in the left pane.

2. Select Project Ö Properties... from the menu bar.

The Project Properties dialog displays the Name property page.

3. Select the Alternative option button.

4. Type the path to the working directory for your workstation.

Or,

Click Browse... to simplify this process.

  NOTE: 
When security is enabled, only an administrator can select or clear the Force Defau
Working Directory check box. When it is selected, users cannot set alternative work
directories for that subproject.
Managing Projects 2-7
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Using Security

Security is set at the project level. It can be modified at the subproject level using the
rity templates explained in Chapter 3, “Managing Subprojects.” At the project level, t
actions a team member can perform depend on whether or not the team member is 
administrator.

To enable or disable security:

1. Select the root subproject from the project tree.

2. Select Properties... from the Project menu or context menu.

The Project Properties dialog opens

3. Select to enable or clear to disable the Security check box.

The Administrator’s Role

The first team member added to a project automatically becomes its administrator. Y
add this team member as you create the project. 

When project security is enabled and security templates are not used, only administr
can:

• Create subprojects or branch subprojects

• Modify project and subproject properties. For example, this means that only an 
administrator can enable security.

• Move files or subprojects using drag-and-drop

• Modify file properties

• Delete versions

• Purge non-permanent versions

• Change a version’s status from permanent to non-permanent
2-8 Versions User’s Guide
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• Change the number of non-permanent versions stored for a file

• Delete projects

• Remove subprojects or files from version control

• Manage the team list
- Add or delete users and groups
- Give users passwords or administrator status
- Modify user properties (non-administrators can only view the properties)
- Add users to or remove them from groups

• Break locks set by other users

• Designate builds and milestones

• Clear the audit log

Depending on the security template used at the subproject level, you can allow som
administrators to perform file actions (such as deleting files) that are normally restric
to administrators.

The Team Member’s Role

Version control can be important for one individual working on a single file that will ha
several iterations. However, it is crucial when a group of individuals work on the sam
of files. Using Versions, team members can lock the files they are currently changin
prevent others from accidentally overwriting those files. After a team member modifi
working file and checks it in, Versions stores the file’s contents as a new version in t
project vault.

Depending on the security template used at the subproject level, you can restrict the
actions of some team members even more. For example, you can prevent some me
from checking in files.

When project security is enabled and security templates are not used, any team me
(referred to as a user by Versions) can:

• Add files to projects and subprojects

• Lock and unlock files
Managing Projects 2-9
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• Check files in and out

• Merge files

• Change a version’s status from non-permanent to permanent

• Change a personal password

• Change the full name, a user property used for e-mail purposes

• View the audit log

• Create reports and charts

Creating a Project

Creating a project allows you to put files under version control and audit users’ actio

Before you create the project, you may need to consider the following:

• Will you need project security, so that actions such as deletions can only be per-
formed by an administrator or specified users?

• Is the project’s granularity sufficiently fine? For example, builds and milestones 
affect every file in the project. If you have subprojects that would normally have t
own build and milestone cycles, those subprojects may need to be independent 
projects with their own project database files (.stp).

• Is the project’s granularity excessively fine? For example, if the project has the s
build and milestone cycle and shares numerous files with another project, perhap
two projects should be subprojects of one project instead of independent.

  TIP
The first user, added when the project is created, is always an administrator by defa
When some users create projects, they log on for the first time using the name Admin
tor. This makes Administrator a team member. The administrators also make themse
team members using their own names.
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When you create a project, you provide a project name, designate a working directo
and provide the name and location of the project database file (.stp). 

To create a project:

1. Click New Project .

Or,

Select Project Ö New... from the menu bar.

The New Project dialog opens.

2. Type a name for the project in the Project Name text box. The project name sho
reflect the nature of the project. Use a maximum of 228 characters. Do not use f
ward slashes (/), backward slashes (\), or exclamation points (!).

3. Type the path to the directory to be used on individual workstations as the defau
working directory for this project in the Default Working Directory text box.

Or,

Click Browse... to locate that directory.
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Do not use Universal Naming Convention (UNC) pathnames or all users will be 
forced to use the same working directory. For example, the working directory 
c:\bigproj\working specifies a working directory on each user’s local c: drive, whi
the working directory \\domain\mydisk\working specifies that physical location fo
single working directory shared by all team members.

4. Select the Force Default Working Directory check box to require all users to use
root subproject’s default working directory for working files on their workstations.

Clear this box to allow users to specify their own working directories for these file

5. Select the Configure Subdirectories As Subprojects check box so that all subdire
ries of the project’s working directory become the default working directories of s
projects. The names of the subdirectories become the names of the subprojects

Clear this box to create no subprojects at this time.

6. The Force Default Working Directory For Subprojects check box is enabled only
when you select Configure Subdirectories As Subprojects. Select this box to req
all users to use each subproject’s default working directory for working files on th
workstations.

Clear this box to allow users to specify their own working directories for these su
projects.

7. The Security check box is selected by default, requiring passwords to log on to t
project and security privileges to perform certain actions. Clear it to allow anyone
complete access to the project.

8. The Audit Log check box is selected by default so that all actions performed on 
project will be logged. Clear it to disable logging events.

9. Type name of the project database file in the File Name text box. By default, the
name has the extension .stp.

10. Type the path to the directory where you will store the project database file. Vers
also stores the project vault there.

Or,

Click Browse... to simplify this process. 
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Usually the project database file is on a network drive in a location that is acces
to all team members.

11. Click Advanced... to set additional options.

The Advanced Projects Settings dialog opens.

Use it to specify:

• Defaults for the project and for project files

a. Select the Defaults tab.

The Defaults property page opens.

Versions can store a maximum of 32767 versions of files using either de
storage or omega storage. 

b. Select the Maximum or Limited option button for one of the storage type

c. If you selected Limited, type a number of versions in the Limited text bo

d. Repeat steps b and c for the other type of storage, if applicable.

e. To stamp working files with the time the version is copied to the working
directory, select Time Stamp Working File With Check-Out Time.

Clear this box to copy the time stamp of the version along with the versio

f. Select the Use Mail check box to use a MAPI-compliant mail system fro
Versions. For example, if you are logged on to e-mail, others are notifie
you break their locks on files.

g. Select the Keyword Expansion check box to use keywords in your text fi
The keywords will be replaced with information stored by Versions. For 
example, $Author$ is replaced with the name of the user who checked in
version. See the “Using Keywords in Files” section of Chapter 4 for deta

h. Select the Use Compression check box to compress all the files stored i
vault.

• Build and test commands:

a. Select the Commands tab.

b. Type the path to the command executable or batch file in the Build 
Command and/or Test Command text box.
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Or,

Click Browse to locate the executable or batch file within your system en
ronment and enter its name into the text box automatically.

• Files never to be added to the root subproject

a. Select the Exclude tab.

b. Select the Use Exclude List check box.

c. Type the file specifications in the Exclude List text box. Separate the 
specifications with semicolons or commas. For example, use “*.obj, *.ba
and Versions ignores all the *.obj and *.bak files in the working directory
They never appear in the list of files that are not in the project.

• A project description:

a. Select the Description tab.

b. Type a project description of up to 255 characters.

12. Click OK.

The New User dialog opens.

To finish creating a project:

1. In the User Name text box, type the name you will use to log on to this project or
name Administrator (to create a first user that can be used by anyone performing
administrative functions).

Select this name carefully, because it cannot be changed. (Usually people use th
network logon name.)

2. In the Full Name text box, type your e-mail name if you are using e-mail within V
sions.

When using Microsoft Exchange, the full name and the Exchange profile name 
should be the same. Otherwise Microsoft Exchange returns an error message ea
time you log on to the Versions project. If this occurs, create a new Exchange pr
with the same name as your Versions full name.
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3. If you enabled project security, you must also type and confirm a password.

Passwords are case-sensitive and must contain at least six characters.

4. Click OK again.

Accessing an Existing Project

You access a project by opening it and logging on to it.

To log on to a project:

1. Select Project Ö Open... from the menu bar.

The Open dialog opens. 

2. Locate and select the project database file (.stp) for your project, then click Ope

The Log On dialog opens.

3. Type your logon name in the User Name text box. 

If security is disabled, User Name is the only text box in this dialog. If you are no
already a team member for a project without security enabled, logging on adds y
the team with the name you have specified. Select your name carefully, becaus
cannot be changed. 
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The full name and the Exchange profile name must be the same. Otherwise Micr
Exchange generates an error message each time you log on to the Versions pro

4. If security is enabled, type your password in the Password text box. 

Your password is blank if you used this project without a password at a time whe
security was not enabled yet.

5. Click OK.

The Project window displays the tree for your project. The name of your project 
its .stp file appears on the title bar. 

By default, the item selected from the tree is the root subproject. It has the same 
as your project.

  TIP
Select the name of a recently opened project from the bottom of the Project menu.

Modifying Properties

As the project administrator, you can modify the following project properties:

• Name

• Working directory

• Use of:

- Audit log

- Compression

- Mail

- Security

- Keyword expansion

- Check-in features

• Description
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• Maximum versions

• User and group privileges to the files in the root subproject
(See the “Setting Up Subproject Level Security” section in Chapter 3 for details.

• Build and test commands

• List of excluded file specifications 
(See the “Exclude Files” section in Chapter 3 for details.)

• Time stamp for working files

You can also review the audit log assigned to the project from the Project Properties
log. The Audit Trail property page has a context menu that allows you to perform op
tions. 

For more detailed information about modifying these properties, see “Creating a Pro
earlier in this chapter. The properties were originally set when you created the projec
more information about assigning privileges to users via the Users tab, see the “Set
Up Subproject Security” section in Chapter 3.

To modify project properties:

1. Select the root subproject from the project tree.

2. Select Properties... from the Project menu or context menu.
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The Project Properties dialog opens.

3. Select the appropriate tab: Name, Users, Defaults, Commands, Exclude, Descri
Defects, or Audit Trail.

4. Change the settings for the properties.

Building and Testing Projects

Versions allows you to associate a Build and/or Test command with the root subproj
Once the commands are associated with the root subproject, command execution is 
menu selection or button click away.
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To execute a Build command:

1. Select the root subproject.

2. Select Project Ö Build  from the menu bar.

Or,

Click Build .

To execute a Test command:

1. Select the root subproject.

2. Select Project Ö Test from the menu bar.

Or,

Click Test .

Designating a Build

A build represents a quantifiable step of progress. For example, a software developm
project may deliver a new build every few days to the team members who test the pro
This feature is not available at the subproject level. When project security is enabled,
an administrator can designate a build.

When you designate a build, you create a single set of versions for the files in the pr
The specified version of each file receives the build label.

For example, suppose the same version of a file ends up in two separate builds and 
stone. That version stores both build labels and the milestone label. A version can h
any number of labels.
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To designate a build:

1. Select the root subproject from the project tree.

2. Select Project Ö Designate Build... from the menu bar.

The Designate Build dialog opens.

3. Type a name or label for the build in the Name text box.

4. Indicate what versions to include by selecting one of the following option buttons

• Latest Version, for the most recent versions.

• As Of, for the versions checked-in at or before the date and time you specify

a. To specify the date, type the date in the text box.

Or,

Click the button between the date and the time to use the calendar. Spe
the date using the next and previous month buttons and the arrow keys.

b. To specify the time, type the time in the text box, then select the AM or P
option button.
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Designating a Milestone
A milestone represents a significant step in progress for a project. For example, the 
may indicate the alpha, beta, or final release of a product. When project security is 
enabled, only an administrator can designate a milestone.

In Versions, a milestone designates a single set of versions for the files in a project.
specified version of each file receives the milestone label and becomes permanent.

To designate a milestone:

1. Select the root subproject from the project tree.

2. Select Project Ö Designate Milestone... from the menu bar.

The Designate Milestone dialog opens.

3. Type a name or label for the milestone in the Name text box.

4. Indicate what versions to include by selecting one of the following option button

• Latest Version, for the most recent versions.

• As Of, for the versions checked-in at or before the date and time you specif

a. To specify the date, type the date in the text box.

Or,

Click the button between the date and the time to use the calendar. Spe
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b. To specify the time, type the time in the text box, then select the AM or P
option button.

• Build, for the versions in the build specified using the Build drop-down list bo

Changing Project Defaults

You can change the project defaults that control how many versions of files are store
the vault, how checked-out files are time stamped, whether keyword expansion and 
pression are used, and whether mail is enabled.

To change project defaults for the project:

1. Select the root subproject from the project tree.

2. Select Properties... from the Project menu or context menu.

The Project Properties dialog opens

3. Select the Defaults tab.
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The Defaults property page opens.

The number of non-permanent versions stored for any file in the project depend
the file’s storage type. By default, Versions stores a maximum of 32767 versions
files using either delta storage or omega storage. 

4. Select the Maximum or Limited option button for one of the storage types.

5. If you selected Limited, type a maximum number of versions in the Limited text b

6. Repeat steps 4 and 5 for the other type of storage, if applicable.

7. To stamp working files with the time the version is copied to the working director
select Time Stamp Working File with Check-Out Time.

Clear this box to copy the time stamp of the version along with the version.

8. Select the Use Mail check box to use a MAPI-compliant mail system from within
Versions. For example, if you are logged on to e-mail, others are notified if you b
their locks on files.
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9. Select the Keyword Expansion check box to use keywords in your text files. The
words will be replaced with information stored by Versions. For example, $Autho
is replaced with the name of the user who checked in the version. See the “Usin
Keywords in Files” section of Chapter 4 for details.

10. Select the Use Compression check box to compress all the files stored in the va

11. Select Force check-in reason to require users to enter check-in comments.

Moving a Project and Project Vault

Versions does not automate the process of moving a project. You can, if the need ar
move the project manually. Be sure to move both the project database file and the p
vault directory to the new location.

To move a project and project vault:

1. Before you begin, do both of the following:

• Verify the name of the project database (.stp) file, which appears in the title 
of the project window, then close the project.

• Verify that no team members are currently logged on to the project.

2. Using File Manager or Windows Explorer, locate the .stp file to be moved. In the
same directory, locate the .vlt directory that stores the vault files for the project d
base file. (For example, if the project file is named project1.stp, the project vault 
directory is named project1.vlt.)

3. Using any valid method, move the .stp file and the .vlt directory to the new locati

4. Notify all team members of the new project location.

If you fail to move the vault and attempt to check out a file, Versions cannot find it an
returns the error “The vault file does not exist.”
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Deleting Projects

Deleting a project is extremely dangerous. It deletes all project data forever. When project 
security is enabled, only an administrator can delete a project. Use the following proce-
dure with great caution.

To delete an entire Versions project:

1. Before you begin, do both of the following:

• Verify the name of the project database (.stp) file, which appears in the title 
of the project window, then close the project.

• Verify that no team members are currently logged on to the project. Version
cannot delete a project that is in use.

2. Select Project Ö Delete... from the menu bar.

The Delete Project dialog opens. 

3. Locate and select the project database (.stp) file to delete.
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The Administrator Verification dialog opens.

4. Confirm project deletion by typing your password.

Versions deletes the project database file, the project vault, and all stored file 
versions. Working copies of files stored locally are not deleted.
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Chapter 3
Managing Subprojects
Subprojects can be created automatically at the same time you create a project or a
subproject or they can be added later. If they are created automatically, all of the 
following are true:

• Their default working directories are subdirectories of the default working directo
for the project or parent subproject.

• Their names are the same as the names of the subdirectories.

• You can make the decision about whether their default working directories are m
datory as you create the project or parent subproject. 

The root subproject, which has the same name as the project, is always created at th
time as the project. To change the project properties, this subproject should be selec

If subprojects are created later:

• Their default working directories can be any directories you choose.

• Their names can be different than the names of their working directories.

• You can make the decision about whether the default working directories are ma
tory as you create the subproject.

For more information on working directories, see “Using Working Directories” later in
this chapter.

Managing a subproject is very similar to managing a project. You can create and de
them, and modify their properties. Their properties are, for the most part, a subset o
properties for a project. 
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The main difference is that you can assign privileges on a subproject-by-subproject b
to individual users or groups of users by means of security templates. Security temp
are defined at the project level and applied at the subproject level.

Using Working Directories

You use a directory, called a working directory, on your workstation to edit or modify
files that belong to a subproject. Each subproject has a default working directory. Us
the default directory means that one team member working on subproject files on on
workstation has the same directory structure for those files as another team member
ing on another workstation. However, depending on the subproject’s options, you ca
ignate a working directory on a per workstation basis. For example, the default work
directory might be “C:\StarDraw\Beta Materials”, but you might use “C:\StarDraw Be
on the workstation in your office and “D:\StarDraw Beta” on your laptop.

Versions expects you to add and check in subproject files from a working directory. W
you check out subproject files, Versions copies files versions to the subproject’s wor
directory. If the specified working directory does not exist, Versions creates it for you
you check out the files. 

You can also select Project Ö Subproject Ö Create Directory Structure from the 
menu bar to create the needed directory structures. For example, if you want to add 
to an existing subproject, but do not need to check out any files, use Create Director
Structure, move the file to the working directory, then add it to the project.

If you create a subproject for which a directory structure already exists on your work
tion, you can request that Versions make a subproject for each subdirectory in the st
ture. 

To change the working directory on your workstation for a subproject:

1. Select a subproject from the project tree in the left pane.

2. Select Project Ö Properties... from the menu bar.
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The Subproject Properties dialog displays the Name property page.

3. Select the Alternative working directory option button.

4. Type the path to the working directory for your workstation.

Or,

Click Browse... to simplify this process.

  NOTE: 
When security is enabled, only an administrator can select or clear the Force Defau
Working Directory check box. When it is selected, users cannot set alternative work
directories for that subproject.
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Creating a Subproject

Creating a subproject allows you to put files under version control and audit users’ 
actions.

 When project security is enabled, only an administrator can create a subproject.

To create a subproject:

1. From the project tree, select the subproject to which the new subproject will be l

2. Click New Subproject .

Or,

Select Project Ö Subproject Ö New... from the menu bar or New Subproject... 
from the context menu.

The New Subproject dialog opens.

3. Type a name for the subproject in the Subproject Name text box. Use a maximu
228 characters. Do not use forward slashes (/), backward slashes (\), or exclama
points (!).

4. Type the path to the default working directory for the new subproject.

Or,

Click Browse... to locate that directory.

If the working directory does not exist, Versions can create it for you.
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Do not use Universal Naming Convention (UNC) pathnames or all users will be 
forced to use the same working directory (instead of local directories with identic
pathnames). For example, the working directory c:\bigproj\working specifies a w
ing directory on each user’s local c: drive, while the working directory 
\\domain\mydisk\working specifies that physical location for a single working dire
tory shared by all team members.

5. Select the Force Default Working Directory check box to require each user to st
the working copies of the subproject files in the working directory on his or her w
station with the path that you specified as the default.

Clear this box to allow users to specify their own working directories for these fil

6. Select the Configure Subdirectories As Subprojects check box so that all subdir
ries of this subproject’s working directory become the working directories of sub
projects. The names of the subdirectories become the names of the subprojects

Clear this box to create no additional subprojects at this time.

7. The Force Default Working Directory For Subprojects check box is enabled only
when you select Configure Subdirectories As Subprojects. Select this box to req
every user to store each subproject’s working files on his or her workstation in th
working directory specified by the default working directory and the path from it 
the subdirectory.

Clear this box to allow users to specify their own working directories for these fil

8. Click Advanced... to set additional options.

The Advanced Subproject Settings dialog opens.

Use it to specify:

• Privileges for users and groups.

See the “Setting Up Subproject Level Security” section later in this chapter f
more information.
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• Build and test commands:

a. Select the Commands tab.

b. Type the path to the command executable or batch file in the Build 
Command and/or Test Command text box.

Or,

Click Browse to locate the executable or batch file within your system en
ronment and enter its name into the text box automatically.

• Files never to be added to the subproject

a. Select the Exclude tab.

b. Select the Use Exclude List check box.

c. Type the file specifications in the Exclude List text box. Separate the 
specifications with semicolons or commas. For example, use “*.obj, *.ba
and Versions ignores all the *.obj and *.bak files in the working directory
They never appear in the list of files that are not in the subproject.

• A subproject description:

a. Select the Description tab.

b. Type a subproject description of up to 255 characters.

To finish creating the subproject:

1. After completing the steps explained above, click OK.

The new, but empty, subproject appears in the project tree. Versions adds the n
subproject to the project database.

2. Select the Files Not In Project filter from the Filter drop-down list box to see the f
that can be added to the subproject and, therefore, to the project vault.
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Setting Up Subproject Level Security

To setup subproject level security, you must create security templates and then ass
users or groups to those templates on a subproject-by-subproject basis. While you c
create templates and assign users and groups under any circumstances, security is
enforced unless it is set as a project property. Administrators always have full privile
in any subproject. The templates apply only to non-administrators.

To enforce security:

1. Select the root subproject from the project tree.

2. Select Properties... from the Project menu or context menu.

3. Select the Security check box.

Managing Security via Security Templates

Use security templates to assign users or groups of users certain privileges normally
reserved for administrators. You can also use templates to limit the privileges of som
users. Only an administrator can assign security templates to subprojects and assign
or groups to those templates. Each user, group, and template must have a unique n

A default template, named Default, comes with Versions. It is preset to the usual no
administrator privileges, but it is editable. 

Also, a default group of users called All Users comes with Versions. Assigning All Us
to a template in a subproject, gives every non-administrator the same privileges in th
subproject. 

If you assign All Users to the Default security template in the root subproject when n
other security templates are used in any subprojects, every non-administrator has the
privileges in every subproject. In fact, that is the default when a new project is create
with security enabled.
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You can give users or deny them the right to:

• Add files.

• Read files. 

This permits users to check out files (but not check them in).

• Read and write files. 

This permits users to check them out to be changed, and check them back in.

• Delete files.

If no security template is assigned to a user in a subproject, she or he has the right i
subproject that they have in its parent subproject.

No user or group can be assigned to more than one template per subproject. Howev
user is assigned individually and then in one or more groups in a subproject, she has
maximum (or union) of those privileges in that subproject. For example, if one templa
allows her to delete files but the others do not, she can delete files. 

Deleting users from a project automatically deletes them from any groups and templa
which they were assigned.

To create a template:

1. Select Project Ö Security Templates... from the menu bar. 

The Project Security Templates dialog opens. 
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2. Click New....

The Template dialog opens.

3. Type the name for the new template then click OK.

For example, you might want templates for superusers, general users, and gues

The new template name appears in the Project Security Template dialog. 

By default, the first three check boxes are selected, giving users the usual non-a
istrator rights. The Read check box is always selected and cannot be cleared wh
ever Modify is selected.

4. Leave the Add check box selected if the users assigned to this template should
allowed to add files to a to-be-determined subproject. Clear it to prevent these u
from adding files.

5. Leave the Modify check box selected to allow users to check files in and out. Cle
to prevent these privileges.

6. If you clear the Modify check box, you can also clear the Read check box, preve
users from checking out files. 

7. Select the Delete check box to allow users to delete files. Leave it cleared to pre
these users from deleting files.

To modify a security template:

1. Select Project Ö Security Templates... from the menu bar. 

The Project Security Templates dialog opens. 

2. Select the security template to be modified.

3. Select and/or clear the appropriate check boxes.
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To delete a security template:

1. Select Project Ö Security Templates... from the menu bar. 

The Project Security Templates dialog opens. 

2. Select the security template to be deleted.

3. Click Remove.

The template is deleted. It can no longer be used by any subproject.

Managing Users Privileges Within Subprojects

After you create security templates, you can assign users and/or groups to those tem
on a subproject-by-subproject basis. In this way you can define a standard set of priv
to be used by different users in different subprojects. For example, the group testers
have superuser privileges only in the Test Suites subproject while the marketing grou
superuser privileges only in the Marketing Materials subproject.
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To assign users or groups of privileges within a subproject:

1. Select a subproject from the project tree.

2. Select Properties... from the Project menu or context menu.

The Project Properties (for the root subproject) or the Subproject Properties dial
opens.

3. Select the Users tab.

4. Select a security template from the Template drop-down list box.

In this way, you select a standard set of privileges.

5. Click Add....

The Add Users dialog opens.

6. Select one or more users or groups from the list box, then click OK.

In this way, you determine to whom that standard set of privileges will apply.
Managing Subprojects 3-11



ct.

 as 

og 
7. Repeat steps 4 through 6 for any other templates to be used within this subproje

The end result for the User Manual subproject (in the StarDraw project) might be
shown in the following figure:

This gives JMarinello guest privileges and the members of the writers group 
superuser privileges within this subproject.

To remove privileges from users or groups within a subproject:

1. Select a subproject from the project tree.

2. Select Properties... from the Project menu or context menu.

The Project Properties (for the root subproject) or the Subproject Properties dial
opens.

3. Select the Users tab.

4. Select the names of one or more users or groups from the list box.

5. Click Remove.
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Modifying Properties

As a project administrator, you can modify the following subproject properties:

• Name

• Working directory

• Description

• User and group privileges to the files in a subproject

• Build and test commands
(See the “Building and Testing Subprojects” section later in this chapter.)

• List of excluded file specifications
(See the “Excluding Types of Files” section later in this chapter.)

You can also review the audit log assigned to the subproject from the Subproject Pr
ties dialog. The Defects and Audit Trail property page has a context menu that allows
to perform operations. For example, you can review an event’s properties.

To modify subproject properties:

1. Select a subproject from the project tree.

2. Select Properties... from the Project menu or context menu.
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The Subproject Properties dialog opens.

3. Select the appropriate tab: Name, Users, Commands, Exclude, Description, Def
or Audit Trail. (A subproject does not have a Defaults tab. Its security, use of the
audit log, etc. are all project-dependent.)

4. Change the settings for the properties.

Building and Testing Subprojects

Versions allows you to associate a Build and/or Test command with each subproject. 
the commands are associated with the subproject, command execution is only a me
selection or button click away.

To associate a Build and/or Test command with a subproject:

1. Select the subproject.

2. Select Project Ö Properties... from the menu bar.

The Subproject Properties dialog opens.
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3. Select the Commands tab.

4. Type the path to the command executable or batch file in the Build Command an
Test Command text box.

Or,

Click Browse to locate the executable or batch file within your system environme
and enter its name into the text box automatically.

To execute a Build command:

1. Select the subproject to build.

2. Select Project Ö Build  from the menu bar.

Or,

Click Build .

To execute a Test command:

1. Select the subproject to test.

2. Select Project Ö Test from the menu bar.

Or,

Click Test .

Excluding Types of Files

You can exclude certain file types. Users do not see excluded files when they use the
Not In Project filter so they cannot add them to the subproject. For example, if you n
want to add files from a subproject’s working directory that have the extension .obj, 
exclude them. Each exclude list applies to files in only one working directory (the one
the selected subproject).
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To exclude file types from view:

1. Select the subproject from the project tree.

2. Select Properties... from the Project menu or context menu.

The Project Properties or the Subproject Properties dialog opens.

3. Select the Exclude tab.

4. Select the Use Exclude List check box.

5. Type the file specifications in the Exclude List text box. Separate the specificatio
with semicolons or commas. For example, use “*.obj, *.bak” and Versions ignore
the *.obj and *.bak files in the working directory. They never appear in the list of fi
that are not in the project.
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Branching and Merging Subprojects

When you branch a subproject, Versions stores versions for the branched files sepa
from the original file versions. This allows parallel development using two sets of sub
project files. Files in subprojects that have been branched can be merged back toge
a later date.

To branch a subproject:

1. Select the subproject to be branched.

2. Select Project Ö Subproject Ö Branch... from the menu bar.

The Branch Subproject dialog opens.

3. Type a name for the branch subproject in the Branch Name text box.
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4. Type the path for the working directory for the branch subproject’s files.

Or,

Click Browse... to locate the working directory.

NOTE

Do not use Universal Naming Convention (UNC) pathnames or all users will be 
forced to use the same working directory (instead of local directories with identic
pathnames). If you specify a directory that does not exit,Versions can create the
directory for you.

5. Select one of the following check boxes to indicate what versions will be the initi
versions in the branched subproject:

• Latest version to use the most recent versions.

• Version Label to use the versions with a specific label selected from the Versio
label drop-down list box.

• As Of to use the version checked-in at or before the date and item you specify.

a To specify the date, type the date in the text box.

Or,

Click the button between the date and the time to use the calendar. 

b To specify the time, type the time in the text box, then select the AM or PM 
option button.

6. To branch the selected subproject and its children based on the above criteria, s
the Branch Child Subprojects check box. 

NOTE

This check box will only be available if all children subprojects have working director
that are subdirectories of the selected subprojects.
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Versions can merge branched files back into the original subproject’s working direct
This merge operation incorporates the changes that have been made to the branch f
the changes that have been made to the original file by comparing each of these file
the version at which the branching took place.

To merge the original and branch subproject files, use the Versions command-line m
function (stcmd mrg)—not Files Ö Merge.... See Chapter 13, “Using the Command-lin
Interface,” for more information on the command-line interface.

Deleting Subprojects

Deleting a subproject from a project deletes all the audit entries and other informatio
associated with the subproject. Optionally, you can delete the vault files, child sub-
projects, and even working files.

To delete a subproject:

1. Select a subproject from the project tree.

2. Select Project Ö Subproject Ö Delete... from the menu bar.

The Delete Subproject dialog opens.

3. Select the Delete Vault Files check box to delete the versions in the vault for this
project. When cleared, these files become attached to the deleted subproject’s p
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4. Select the Delete Child Subprojects check box to delete the subproject’s subpro
When cleared, these subprojects become the children of the deleted subproject’
ent.

5. Select the Delete Working Files check box to delete the corresponding working 
from their working directories. Clear the box to leave the working files undisturbe
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Chapter 4
Managing Files
When a file is under version control, Versions maintains the 
information needed to recreate any stored version of that file.

Storage methodVersions uses both omega and delta storage depending on the 
type of file. 

Binary filesVersions always stores each version of a binary file in its 
entirety (omega storage). 

Text (ASCII) filesBy default, Versions stores the latest version of a text file in its 
entirety. For all other stored versions, only the differences 
between one version and the next are saved (reverse delta 
storage). 

For very large text files that have numerous changes, 
specifying omega storage may shorten the check-in time 
because there is no need to check for differences. Once a text 
file has been stored using omega storage, it will always be 
stored using omega storage.

CompressionWith either method, the versions stored in the vault can be 
compressed.

How many versions 
are stored?

Versions stores all versions of the file you designate as 
permanent. In addition, it stores a specific number of the most 
recent non-permanent versions. For example, suppose the 
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maximum is 10 non-permanent versions. When the 11t
non-permanent version is checked in, the first non-
permanent version is automatically deleted. 

You set a default maximum for non-permanent versions
of any project file as a property at the project level, but 
you can override that maximum for specific files as you
add them to the project or, later, by changing their file 
properties. 

You can perform additional clean-up by deleting 
permanent versions or by purging all non-permanent 
versions from the file. However, one version must alway
be left in the vault file. To get rid of all versions, delete th
file from the project.

Grouping versions of 
files

Versions allows you to label a set of versions as a build 
a milestone. For example, if the project reaches a 
particular milestone (such as beta) on a particular date,
selecting that project and designating a milestone gives
the most recent version of each project file the same lab
This allows you to check out those versions as a group 
any time. Designating a milestone also makes those 
versions permanent—although designating a build does
not. 

The same version of a file may end up in several builds 
milestones. This is not a problem because a version ca
have any number of labels. However, no label can be 
repeated. For example, you cannot add a version to a bu
or milestone by giving it the same label as that build or 
milestone.

Labeling versions as you 
check files in

You can also label a group of versions (or a single 
version) as you check files in. This makes it easier to 
check those specific versions out again at a later time.
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History and audit logVersions preserves historical information about each 
version and logs information about actions performed. For 
example, the audit log indicates when and by whom a file 
is added to a project, checked in, and purged of non-
permanent versions.

Links to defects If you use Versions with StarTeam Workstation, you can 
view and edit defects found in your program. As you 
check a file in, you can resolve defects associated with it 
at the same time. Defect resolutions are associated 
automatically with the next build number. This lets testers 
know which build to test.

Using the Files List

  TIP
Right-click to see 
context menus.

When you select a subproject from the project tree, the 
Files tab becomes available. If you select the tab, the files 
associated with the subproject appear in the right pane, 
and the Files menu appears on the menu bar.
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The files list in the following figure displays all the files in
the StarDraw project (sorted by subproject).

What the files list displays depends on:

• What subproject you select from the project tree

• The filter you select from the Filter drop-down list 
box

• The depth you specify with a scope button

Icons Two icons precede the name of each file. One indicates
the type of file, such as a document, text, or graphics fil
The other indicates whether the file is:

Not locked by anyone

Locked by you

Locked by another team member

Not in the project

Columns The files list contains several columns, each with its ow
column header. 
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The columns for the files list are:

Name Name of the file (including any exten-
sion).

Ext Extension of the file.

Locker Person who currently has the file 
locked.

Exists Indicates whether the file is in your 
working directory.

Size Size of the working file in bytes.

Time stamp Time stamp for the working file.

Max vers Maximum number of non-permanent 
versions to be stored for this file.

Description Description of the file provided when it 
was added to the project.

Author Person who added the file to the project.

Subproject Subproject containing the file.

Path Path to the file’s working directory.

SortingClick a column header to sort the displayed files based on 
the value in that column. The sort order for each of these 
columns is ascending alphanumeric. To change the sort 
order from ascending to descending, click the header a 
second time. Right-click another header for a secondary 
sort. The primary sort column’s header is underlined.
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Using File Filters

Selecting a filter from the Filter drop-down list box allows you to limit the kinds and 
quantity of files that appear in the files list. What is displayed is also affected by your 
selection from the project tree and the scope buttons.

The filters are:

Files in project Displays the files in the working directory that exist in the 
project.

Files not in projectDisplays only the files that are in the project’s working direc-
tory but not in the project. Unless you add them to the project, 
their names never appear on the same list as the files that are in 
your project. 

Files to check in Displays the files in the working directory for which the work-
ing file is more recent than the latest checked-in version. Ver-
sions checks both the size and time stamp for changes.

Files to check out Displays the files for which the latest checked-in version is 
more recent than the working file or for which there is no 
working file. (Files that are not in the working directory have 
the value No in their Exists columns.)

Versions records the version number for the version of each 
file currently in your working directory. If that number is less 
than the current version number for the file, the file needs to be 
checked out. If, for some reason, no version number is stored, 
Versions uses the size and time stamp to determine what needs 
to be checked out.



Using a File under Version 
Control

Adding a fileTo place a file under version control, add it to a project. 
The file must be in the working directory for either the 
project or one of its subprojects. Adding the file stores a 
copy of the working file (the version of the file in the 
working directory) as the first version in the vault. This 
means that you can delete the working file without losing 
any data. Versions recreates that version for you any time 
you check it out.

Checking out a versionChecking out a version copies that version of the file to a 
working directory.

Check out a version to be sure that you have the latest or a 
specific version to work on. For example, you may need 
the changes made to the file by a team member or you 
may have deleted the working file earlier, just to save 
space on your hard drive. 

Lock file before changing 
it

If you intend to make changes to the file, you should lock 
it as part of the check-out procedure. The lock makes your 
intention clear to others. Besides, the file must be locked 
before you can check it back in. 

Workstation options for 
check-in, check-out

The defaults for your workstation options indicate how 
you want to check files in and out. However, you can 
override these defaults for specific files by selecting Files 
Ö Check In... or Files Ö Check Out... from the menu 
bar.

For example, if you usually change the contents of project 
files, enable the workstation option Lock Files on Check-
out. Then to check out the occasional file that you won’t 
be editing, select Files Ö Check Out... from the menu bar 
to disable that option. Because the file is unlocked, the 
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working copy becomes read-only if you have selected t
Mark Unlocked Working Files Read-only workstation 
option.

Checking in a version After you change a working file, check it in. You may be
finished with the file or want to retrieve this version as-is
if future changes are cut from the product. Versions 
records the changes as a new version. As part of the 
check-in process, you can remove the lock making the f
available to others or maintain the lock because you wi
continue to make changes to the working file. You can 
also delete the working file.

Check In and Check Out 
dialogs

The context menus and toolbar buttons provide quick 
check in and check out. Only the Check In and Check O
items on the Files menu display dialogs. From the Chec
In dialog, you can change workstation defaults, provide
reasons for checking in files, and resolve defects. From
the Check Out dialog, you can check out files based on
their version labels or their time stamps. Usually, you 
check in files using Files Ö Check In... from the menu 
bar to document the reason for check in. However, mos
people do quick check outs because they want only the
most recent versions.

Merging files Mistakes can happen despite the availability of locks an
communication tools. If two team members change the 
same text file simultaneously or if one member changes
an outdated file, you can use Versions’s merge option t
combine the changes in these files so no work is lost. F
details, see “Merging Files,” later in this chapter.
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Using File Properties

Each file has several categories of properties associated with it.

To view file properties:

1. Select a file from the files list or the project tree.

2. Select Properties... from the Files menu or the context menu.

Or,

Press Alt+Enter.

The File Properties dialog appears.
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Working File Properties

The Working File page displays information about the working file. It tells you:

• The name and path to the working file.

• Whether the file currently resides in the working directory, and, if so, its size, tim
stamp, and status. For example, if the working directory does not contain the file
file’s status is Needs Check-out.

• The description of the file.

Vault File Properties

The Vault File page displays:

• The name of the vault file (with the .VVF extension).

• Its size in bytes.

• Whether it is compressed.

• Its storage type.

• The most recent version number.

• Whether the file is locked and who locked it.

• The number of non-permanent versions that can be stored in the file without bei
automatically deleted.

Other Properties

The History and Audit Trail pages display the history of the file and the entries for it fr
the audit log. These can also be viewed by selecting the file from the project tree the
clicking the History or Audit tabs below the right pane of the project window. Each of
them has a context menu from which you can perform operations. For example, you
compare versions of text files and review the properties for an audit entry.
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See the next section for more information about the History list.

See Chapter 6, “Using the Audit Log,” for more information about the Audit log.

Using the History List

When you select a file from the project tree, the Files tab changes to the History tab
Selecting the History tab displays the selected file’s version history in the right pane,
the History menu appears on the menu bar. However, the Filter list box and the scop
buttons are disabled.

You may prefer to select the History tab from the File Properties dialog shown below 
(Right-click to see a context menu.)
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Icons One icon precedes the name of each version. It indicate
whether the version is:

A non-permanent version that can be automati-
cally deleted when the maximum number of non
permanent versions is exceeded.

A permanent version that can never be automa
cally deleted.

Only non-permanent versions can be purged from a file
and at least one version must remain in a file after the 
purge—even if it is non-permanent.

Columns The history list contains several columns, each with its 
own column header. The columns for the history list are

Version # Number Versions gave the version as
it was checked in.

Time Stamp Date and time of the version.

Author Person who checked in the version.

File Size Size of the version in bytes.

Reason for Reason provided for checking in
Check-In                  the version.

Sorting Click a column header to sort the displayed versions bas
on the value in that column. Version # sorts from highes
to lowest number. Time Stamp sorts from most recent t
earliest time. Otherwise, the sort is in ascending order, 
numeric or alphanumeric depending on the data. To 
change the sort order from ascending to descending (o
vice versa), click the header a second time. Right-click 
another header to perform a secondary sort.
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Group bandsWhen sorting, group bands separate entries with the same 
value in the sort column. When the values of the sorted 
column are likely to be unique (such as a time stamp), no 
group bands appear.

MenusAfter selecting one or more versions from the history list, 
use the History menu or right-click to display a context 
menu.

Double-clickDouble-click a version to see its properties.

Version PropertiesThe properties for a Version include the same information 
that the icons and columns show. In addition, the Version 
property page shows all the version labels that have been 
associated with this version.
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Adding Files to a Project

You can add files from any working directory on your workstation to the subproject t
corresponds to that directory. The contents of the working files become the first vers
of those files stored in the project vault. In fact, the reason for check-in for an added f
automatically “initial version.”

If the working directory for the subproject is not already on your workstation:

1. Select Project Ö Subproject Ö Create Directory Structure... from the menu bar.

Versions automatically creates the path to the working directory for the subproje
you selected. It also creates the working directories for the subprojects of your s
tion.

2. Move the files to be added to the project to the working directory or create them
there.

  TIP
If the administrator allows you to select your own working directories, you can specif
more convenient locations on your workstation’s hard drive for the project or a 
subproject’s files. For example, you might want to use a shorter path or a different d
letter. To specify a working directory, select a subproject from the project tree. Then
select Properties... from the Project menu or a context menu or press Alt+Enter.

To select the files to be added:

1. Select a subproject from the project tree.

2. Select the Files tab below the right pane.

The files list appears in the right pane.

3. Select Files Not in Project from the Filter drop-down list box above the files list.

The files list contains the names of any files in your working directory that are no
already under version control.

4. Select the files to be added from the files list.
4-14 Versions User’s Guide



ect 
ll 
  TIP
Use the All Descendants  or Immediate Descendants  scope buttons to sel
files across multiple subprojects. Use Select All on the Files or context menu to select a
the files simultaneously.

To add files quickly using the current project and workstation defaults:

1. Select the files to be added.

2. Click Add Files .

Or,

Select Add Files from the files list context menu.

To add the files and set options for them:

1. Select the files to be added.

2. Select Files Ö Add Files... from the menu bar.

The Add Files dialog opens.
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3. Select the Lock Files check box to lock the files (with you as the locker) or clear
box to leave the files unlocked at this time. 

When you lock a file, only you can work on it unless another team member brea
your lock. When project security is enabled, only an administrator can break you
lock.

4. Select the Permanent check box to make the first versions of these files perman
clear the box to make the versions non-permanent.

5. Select the Delete Working Files check box to delete the files from your workstat
storing them only in the project vault, or clear the box to leave the working files i
the working directory.

6. By default, text files use delta storage, and binary files use omega storage. If the
selected files are text files that are large and change frequently, select the Force
Omega check box to apply omega storage to these files.

7. The number of non-permanent versions stored for any file in the project depend
the file’s storage type. By default, Versions stores a maximum of 32767 versions
files using delta storage and ten versions for files using omega storage. 

To change the number of non-permanent versions stored:

a. Select the Maximum or Limited option button for one of the storage types.

b. If you selected Limited, type a maximum number of versions in the Limited t
box.

c. Repeat steps a and b for the other type of storage, if applicable.

8. Type a generic description for all the files in the File Description text box.

Or,

Select the Prompt for Description for Each File check box.

9. If retrieving these files later as a group or if retrieving this specific version of the 
file being checked in will be important, type a label in the Version Label text box. 
example, you may label a file as “technical review.”
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10. Click OK.

The names of the selected files disappear from the files list and appear on the p
tree.

The Enter Description dialog opens if you selected the Prompt for Description fo
Each File check box. Type descriptions as necessary.

11. Change the filter above the files list to Files in Project so you can see the names
your files in the files list again.

Setting Version Control Options
Workstation options control how Versions behaves on a specific workstation. Severa
these options are for version control. You can override these options as you check a
ticular file in or out by selecting Files Ö Check In... or Files Ö Check Out... from the 
menu bar and using either the Check In or Check Out dialog.

To set version control options for your workstation:

1. Select Options Ö Workstation... from the menu bar.
The Workstation Options dialog opens.

2. Select the Defaults tab.

3. To lock files as you check them out, select the Lock Files on Check-Out check b
Otherwise the file’s current lock status is preserved.

4. To retain your lock on a file after a check in, select Keep File Locked on Check-

Otherwise the working file is automatically unlocked.

5. To delete the working file as part of the check-in process, select Delete Working F
on Check-in.

Otherwise the file is left in the working directory.
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6. To protect yourself from accidentally updating files that you do not have locked, 
select Mark Unlocked Working Files Read-only. 

Otherwise, you may make changes to unlocked files. (Files accidentally change
this way can be merged with the most recent checked-in version using Files Ö 
Merge from the menu bar.)

Locking and Unlocking Files

You must lock a file before you:

• Check it in.

• Change its maximum number of versions using Files Ö Maximum Versions....

• Remove it from version control using Files Ö Delete....

• Delete one of its versions using History Ö Delete.

• Purge non-permanent versions from it using Files Ö Purge.
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• Change the status of one of its versions from permanent to non-permanent or vi
versa using History Ö Permanent or using History Ö Not Permanent.

To lock a file:

1. Select one file from the project tree.

Or,

Select one or more files from the files list.

2. Select Lock from the Files menu or a context menu.

Or,

Click Lock .

To unlock a file, use Unlock or click Unlock .

Checking In Files

When a file is checked in, the contents of the working file are stored in the project vau
a new version of the file.

The first two procedures check files in quickly using:

• The current workstation and project version control options 

• No reason for checking in the files

The last procedure displays the Check In dialog, shown below, so you can change t
options or supply a reason for check-in.
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To check in a single file quickly using the project tree:

1. Select a file from the project tree.

2. Select Check In from the context menu.

The selected working file is added to the project vault as a new version.

  TIP
Use the All Descendants  or Immediate Descendants  scope buttons to sel
files across multiple subprojects.

To check in files quickly using the files list:

1. Select one or more files from the files list.

2. Click Check In .

Or,

Select Check In from the context menu.

The selected working files are added to the project vault.

To check in files and set options for them:

1. Select one or more files from the files list.

2. Select FilesÖCheck In... from the menu bar.
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The Check In dialog opens.

3. Select the Duplicate OK check box if it is OK to create a version that is identical
the previous one. Clear the box to reject a duplicate version.

4. Select the Permanent check box to make the versions of these files permanent o
the box to make the versions non-permanent.

5. By default, text files use delta storage, and binary files use omega storage. 

If the selected files are text files that are large and change frequently, select the 
Omega check box to apply omega storage to these files.

6. Select the Delete Working Files check box to delete the files from your workstat
storing them only in the project vault or clear the box leaving the working files in 
working directory.

7. Select the Keep Files Locked check box to keep your lock on the checked-in file
Clear the box to unlock the files as part of the check-in process.

8. Type a generic reason for all the files in the Reason for Check-in text box using
maximum of 255 characters.

Or,

Select the Prompt for Reason for Each File check box.
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9. If retrieving these files later as a group or if retrieving this specific version of the 
file being checked in will be important, type a label in the Version Label text box. 
example, you may label a file as “technical review.”

10. If you are using StarTeam Workstation with Versions, click Show Defects to view
and edit files which contain defects. 

11. Click OK.

The Enter Reason dialog opens if you selected the Prompt for Reason for Each 
check box. Type reasons as necessary.

Checking Out the Most Recent Version

When you check out a file using one of the following procedures, Versions copies th
latest version of that file to the working directory for the subproject to which the file 
belongs. 

If a copy of that file is already in the working directory, it is overwritten unless that co
appears to be more recent than the checked in version. Then you are asked to confi
check out. 

For example, if you check a file out, edit it, decide you don’t want your edits, and che
out the file again, you are asked to confirm the check out.

The first two procedures check files out quickly using the current workstation options
check-out. The last procedure displays the Check Out dialog so you can change the
Status option or force a check-out when the latest version of a file is older than the 
working file.

To check out a single file quickly using the project tree:

1. Select a file from the project tree.

2. Select Check Out from the context menu.
The latest version of the selected file is checked out.
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  TIP

Use the All Descendants  or Immediate Descendants  scope buttons to sel
files across multiple subprojects.

To check out files quickly using the files list:

1. Select one or more files from the files list.

2. Click Check Out .

Or,

Select Check Out from the context menu.

The most recent versions of the selected files are checked out.

To check out files and set check-out options:

1. Select one or more files from the files list.

2. Select Files Ö Check Out... from the menu bar.

The Check Out dialog opens.

3. Select the Latest Version option button.
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4. Select the Lock check box if you want to lock the files. Clear it to retain each file
current lock status.

5. You can select Force Checkout to overwrite any working files, even if they are m
recent than those being checked out. 

Checking Out a Previous Version

When you check out a file using one of the following procedures, Versions copies th
selected version of that file to the working directory for the subproject to which the fil
belongs. 

The first procedure allows you to compare versions before you select the one you w
However, you must use the current workstation options for check-out. 

The second displays the Check Out dialog so you can change the Lock Status optio
force a check-out when the latest version of a file is older than the working file. It allo
you to check out versions of more than one file. 

To check out any previous version of a single file:

1. Display the history list by doing one of the following:

• Right-click the name of the file from the files list.
Select Properties... from the context menu.
Then select the History tab from the File Properties dialog.

• Select the name of the file from the project tree.
Then select the History tab below the project window’s right pane.

2. To compare two versions to determine which of the two to check out:

a. Select two previous versions from the history list.

b. Select Compare from the History menu or context menu.
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3. Select the version to be checked out.

4. Click Check Out .

Or,

Select Check Out from the History menu or context menu.

The selected version is copied to the file’s working directory using the current w
station options for check-out.

To check out previous versions of more than one file:

1. Select one or more files from the files list.

2. Select Files Ö Check Out... from the menu bar.

The Check Out dialog opens. This allows you to check out the most recent versi
the selected files. Or you can check out versions of those files with the same lab
check-in date.

3. Indicate what versions you want by selecting one of the following option buttons

• Version Label to check out the versions with a specific label, which you sele
from the Version Label drop-down list box.

• As Of to check out the versions checked-in just before the date and time you
specify.
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a. To specify the date, type the date in the text box.

Or,

Click the button between the date and the time to use the calendar. Spe
the date using the next and previous month buttons and the arrow keys.

b. To specify the time, type the time in the text box, then select the AM or P
option button.

4. Select Lock to lock each file as part of the check-out process. Clear it to preserv
current lock status of each file.

5. Select Force Checkout to overwrite working files, even if they are more recent.

Using Keywords in Files

If Keyword Expansion is enabled for a project, you can embed keywords within a pro
text file. These keywords are automatically expanded during file check-out to provide
and version information within the file.

The keywords available in Versions are:

$Archive$ Fully qualified vault file name

$Author$ User who checked in the version

$Date$ Date and time stamp for the version

$Header$ Combination of Archive, Revision, Date, and Author

$Locker$ User who has the file locked (if any)

$Log$ File change history (see below)

$NoKeywords$ Turn off keyword expansion for the rest of the file

$Project$ Name of the project

$Revision$ Version number
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$Subproject$ Name of the subproject

$Workfile$ Unqualified name of the working file (for example, foo.cpp)

$Log$ Keyword Settings

$Log$ is a special keyword because it expands to a multiline entry. The $Log$ keyw
expands to include information for each version of the file. Version history includes t
Version Number, Date, Author, and Reason for Check In.

Using the $Log$ keyword also allows you to place a line prefix or comment characte
file type in all expanded lines.To ensure that these lines are recognized as comment
can attach a prefix to each line. You can provide different prefixes for files with differ
extension. For example, you can use “rem” for .bat files.

NOTE

 You must have administrative privileges to assign file extension and line prefix pairs
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To add a file extension/prefix pair:

1. Select the root subproject from the project tree.

2. Select Properties... from the Project menu

Or,

Press Alt + Enter.

The Project Properties dialog opens.

3. Select the Defaults tab.

The Defaults property page opens.

4. Select the Keyword Expansion check box (if it is not already checked).

5. Click Settings...

The Keyword Settings dialog opens.

6. Type the extension in the File Extension text box.

7. Type a prefix that will appear in each line of the $Log$ entry in a file with the cor
sponding extension in the Line prefix text box.

NOTE 

 A file extension or line prefix can contain a maximum of 32 characters.

8. Click Add

Your extension/prefix combination appears in the File extension/Line prefix list b

To remove a file extension/prefix pair:

1. Select the File Extension and Line Prefix pair you want to delete from the list bo

2. Select Remove to delete this entry.
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Checking Out a Build or Milestone

Both builds and milestones are sets of file versions with the same label. The milesto
represents a significant step in the life cycle of the product and the versions are 
permanent. Normally, testers and other team members install a build or milestone to
review it. However, sometimes you need the file versions used to create the build or
milestone. For example, if a customer needs a fix for a particular release of software
product, a developer might need to look at the source code that produced that relea

Before checking out a build or a milestone, make sure you check in any files you ha
been working on so the build or milestone does not overwrite those files.

To check out a build or a milestone:

1. Select the appropriate subproject from the project tree.

2. Select the Files tab below the right pane to list all the files.
The files list appears in the right pane.

3. Use the Files in Project filter and the All Descendants  scope button, if appr
ate.

4. Select Files Ö Select All from the menu bar.

5. Select Files Ö Check Out... from the menu bar.
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The Check Out dialog opens.

6. Select version label.

7. Select the build or milestone’s label from the Version Label drop-down list box.

8. Select the Force Check-out check box in case you have more recent versions o
selected files in your working directories.

Only the versions of files that match the label are checked out.

Comparing Files

You can make any of the following comparisons between text files and/or text versio

To compare two versions of a file:

1. Display the history list by doing one of the following:

• Right-click the name of the file from the files list.
Select Properties... from the context menu.
Then select the History tab from the File Properties dialog.

• Select the name of the file from the project tree.
Then select the History tab below the project window’s right pane.
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2. Select two versions of a text file from the history list.

3. Click Compare .

Or,

Select Compare from the History menu or context menu.

Visual Diff, Versions’s differencing program, displays the two versions, indicating
the differences with different colors.

4. Select File Ö Exit  from the Visual Diff menu bar to return to Versions.

To compare a version to the working file:

1. Display the history list as explained in step 1 above.

2. Select one version of a text file from the history list.

3. Click Compare .

Or,

Select Compare from the History menu or context menu.

Visual Diff displays the two files.

4. Select File Ö Exit  from the Visual Diff menu bar to return to Versions.

To compare two working files that are text files:

1. Select a subproject from the project tree.

2. Select the Files tab below the right pane.

The files list appears in the right pane.

3. Select two text files from the files list.
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4. Click Compare .

Or,

Select Compare from the Files menu or context menu.

Visual Diff displays the two files.

5. Select File Ö Exit  from the Visual Diff menu bar to return to Versions.

To compare a text file in the working directory with its most recently checked-in 
version:

1. Select a file from the files list or project tree.

2. Click Compare .

Or,

Select Compare from the Files menu or context menu.

Visual Diff displays the two files.

3. Select File Ö Exit from the Visual Diff menu bar to return to Versions.

See Chapter 12, “Using Visual Diff,” for information about searching for differences a
other features of the Visual Diff application.

Merging Files

Although Versions provides file locking and communication tools to prevent team me
bers from working on files simultaneously, it is not always possible to prevent these 
working collisions. One team member may begin to make changes before locking a 
only to realize too late that another team member has locked it and made changes a
Or a team member working off-site might update an out-of-date file without realizing 
there is a newer version stored in the project vault.
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Versions provides a merge option to combine the changes in these files so that no w
lost. It merges an outdated working file with the most recently checked in version by 
paring the two “new” versions with the version on which the outdated file was based 
the version that was checked out to create the working file).

To merge an outdated working file with the most recently checked in version:

1. Select the file to be merged from the files list.

2. Lock the file by doing one of the following:

• Click Lock .

• Select Lock from the Files menu or a context menu.

3. Select Files Ö Merge from the menu bar.

Versions warns you when the files contain differences (conflicts) and notifies yo
when the files are the same.

After the merge, a merged file, with the differences between the two files clearly
marked, becomes your working file.

4. Edit the merged file to review the changes and resolve conflicts before checking
file in.

Sample of conflict output in merged file:
>>>> === An editing conflict was detected in lines 10 through 10 === 
>>>> The original (root) file contains the following:
BUFFERS=10,0
>>>> The last checked-in version contains the following:
BUFFERS=20,0
>>>> The current working file contains the following:
BUFFERS=30,0
>>>> === End of the conflict section === 

You can use stcmd mrg at the command-line (and not Files Ö Merge) to merge branched 
subprojects. See Chapter 13, “Using the Command-line Interface,” for more informa
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Compressing and Decompressing Vault 
Files

Versions allows you to compress or decompress one or more vault files. Compressi
vault files:

• Reduces disk storage requirements for those files

• Can improve check-in and check-out performance because it reduces disk input
output

To compress or decompress vault files:

1. Select one or more files to be compressed from the files list.

2. Select Files Ö Compress Vault File or Files Ö Decompress Vault File from the 
menu bar.

Modifying File and Version Properties

You can modify the following file and version properties if you have the file locked or
checked out. If security is enabled, only an administrator can change some of the 
properties.

The file properties you can modify are:

• Description

• Maximum number of versions (administrator only)

• File Name
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The version properties you can modify are:

• Status (Anyone can change the status from non-permanent to permanent, but o
administrator can change it from permanent to non-permanent.)

• Reason for check-in 

You can also review a file’s history and audit log from the File Properties dialog.

To modify file properties:

1. Select a file from the project tree. Then select Properties... from the Project menu or 
the context menu.

Or,

Select a file from the files list. Then select Properties... from the Files menu or the 
context menu.

The File Properties dialog opens.

2. Select the appropriate tab: Working File or Vault File, History, or Audit Trail.

3. Change the setting for the property.

To modify version properties:

1. Display the history list by doing one of the following:

• Right-click the name of the file from the files list.
Select Properties... from the context menu.
Then select the History tab from the File Properties dialog.

• Select the name of the file from the project tree.
Then select the History tab below the project window’s right pane.
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2. Double-click the version in the history list.

Or,

Select a version, then select Properties... from the History menu or context menu.

The Version Properties dialog opens.

3. Change the setting for the property.

Deleting a Version

When project security is enabled, only an administrator can delete a version of a file 
the project vault. Use this procedure with caution. The history information for all dele
versions remains in the project database file, even though the deleted versions are n
recoverable. In the file’s history display, the history information for deleted versions i
dimmed.

To delete versions:

1. Select the file from the project tree.

2. Select the History tab below the right pane.

The history list appears in the right pane.

3. Select one or more versions to be deleted.

4. Select HistoryÖDelete from the menu bar.

Or,

Press Delete.

For permanent versions, Versions asks for confirmation.
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Deleting a File

When project security is enabled, only an administrator can remove a file from versio
control. Even when security is disabled, you must lock the file before you can remov
Removing a file destroys all the information about its version history and audit entrie
Use this procedure with caution.

To remove one or more files from version control: 

1. Select a subproject from the project tree.

2. Select the Files tab below the right pane.

The files list appears in the right pane.

3. Select the files to be removed from version control from the files list.

4. Select FilesÖDelete... from the menu bar.

Or,

Press Delete.

The Delete Files dialog opens.

5. Select the Delete Working Files check box to delete the corresponding working 
from their working directories. Clear the box to leave the working files undisturbe
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Sending Versions

You can attach copies of versions to e-mail messages using Files Ö Send To... and 
History Ö Send To.... See Chapter 7, “Using E-mail with Versions” for more 
information.

Reporting and Charting

You can create a number of charts and reports using Files Ö Reports... and Files Ö 
Charts.... See Chapter 8, “Reporting,” and Chapter 9, “Charting,” for more informatio
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Chapter 5
Managing the Team
If you select the Team tab, the team list displays in the right pane. The Team menu also 
becomes available from the menu bar.

The team list displays each user who is a member of the project team. It contains several 
columns, each with its own column header. 

The Filter drop-down list box and the scope buttons are disabled.

  TIP
Right-click to see context menus.
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Icons One icon precedes the name of each user. It indicates the user’s 
status:

 Administrator

 Non-administrator
One icon precedes the name of each group.

Group

Columns The columns for the team list are:

User Name The name used to log on to the project.

Full Name The name used for e-mail.

Admin Indicates (with a Yes or No) whether the 
user is an administrator.

User Type Indicates (with User or Group) whether the 
user entry is an individual or a group users.

Sorting Click a column header to sort the displayed users based on the 
value in that column. Admin sorts Yes to No. User Type sorts 
User to Group. User Type sorts User to Group. Otherwise, the 
sort is in ascending, alphanumeric order. To change the sort 
order from ascending to descending (or vice versa), click the 
header a second time. Right-click another header to perform a 
secondary sort. The primary sort column’s header is under-
lined.

When sorting, group-bands separate entries with the same 
value in the sort column. When the values of the sorted column 
are likely to be unique, no group bands appear.

Menus After selecting one or more users, use the Team menu or right-
click to display a context menu.

Double-click Double-click an entry to see its properties. 
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Adding a User

Any number of users can access a project, but only after they have been added to th
of team members. 

When project security is enabled, only an administrator can add users. Otherwise us
can add themselves as they log on to the project.

If a user is added when project security is disabled, that user has a blank password.
project’s security is enabled later, that user continues to have a blank password unti
administrator or the user changes it.

As you add a user to the project (and if the project has e-mail enabled), VersionsVer
automatically sends e-mail notification to that user about being added to the project t
The e-mail is sent using the user’s Full Name as the address.

To add a user:

1. Select the Team tab below the right pane.

The team list appears.

2. Select Team Ö New User... from the menu bar.

The New User dialog opens.
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3. Type the name that will allow the user to log on to the project in the User Name 
box. This is usually the user’s logon name for the network. Select this name care
because it cannot be changed.

4. Type the user’s e-mail name in the Full Name text box to use MAPI-compliant e-m
from Versions. For example, when a new user is added to a project that has ma
enabled, Versions sends a welcome mail message to that user.

When using Microsoft Exchange, the full name and the Exchange profile name 
should be the same. Otherwise Microsoft Exchange returns an error message ea
time you log on to the Versions project. If this occurs, create a new Exchange pr
with the same name as your Versions full name.

5. If project security is enabled, type the password that will allow the user to acces
project in the Password text box.

6. If you typed a password, retype it in the Confirm text box to prove it was typed c
rectly at step 5.

7. Select the Administrator check box if this user will have administrator privileges.

8. Select the Force Change Password check box if you want the new user to chan
password when logging on for the first time.

Adding a Group

A group consists of any number and combination of team members. You use groups
assign privileges to many users at one time instead of each user individually. When p
security is enabled, only an administrator can create or modify groups.

Suppose you create a group called Testers that contains all the team members who 
testing the product. Suppose you also have a security template that allows team me
to delete files. By assigning the Testers group to that security template for the Autom
Testing subproject, you give each tester the ability to delete files in that subproject. A
testers come and go, you add or delete their names from the Testers group.
5-4 Versions User’s Guide



tion 
 users 
See the “Setting Up Subproject Level Security” section in Chapter 3 for more informa
about security templates, assigning security templates to subprojects, and assigning
and groups to security templates.

To create a group:

1. Select the Team tab below the right pane.

The team list appears.

2. Select Team Ö New Group... from the menu bar.

The New Group dialog opens.

3. Type the name for the group in the Name text box.

4. Click Add....

The Add Users dialog opens.

5. Select one or more users then click OK.
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Controlling Group Membership

You can add users to and remove them from groups using either the Group Properti
dialog or the Group tab of the User Properties dialog. 

Use the Group Properties dialog to make one or more user changes to a group. For 
example, several users might need to be added to an existing group at one time.

Use the Group tab of the User Properties dialog to modiyf the list of groups to which
user belongs. For example, a new team member might need to be added to several 
at once.

To change an existing group’s membership list:

1. Select the Team tab below the right pane.

The team list appears.

2. Select the group to be modified.

3. Select Properties... from the Team or context menu.

The Group Properties dialog opens.

4. To add users:  Click Add... to select additional members from the Add Users dia
(which lists all the team members who are not in this group).

Or,

To remove users:  From the Members list box, select one or more users to be de
then click Remove.

To change the list of groups to which a user belongs:

1. Select the Team tab below the right pane.

The team list appears.

2. Select the user to be modified.
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3. Select Properties... from the Team or context menu.

The User Properties dialog opens.

4. Select the Group tab.

The Group property page opens.

5. To add groups:  Click Add... to select additional groups from the Add Groups dia
(which lists all the groups that do not include this user yet).

Or,

To remove groups:  From the Membership list box, select one or more groups to
which the user should not belong. Then click Remove.
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Changing Your Password

When project security is enabled, you can change your personal password. 

To change your password:

1. Select the Team tab below the right pane.

The team list appears in the right pane.

2. Double-click your name in the team list.

Or,

Select your name. Then select Properties... from the Team menu or the context 
menu.

The User Properties dialog opens.

3. Type the new password in the Password text box.

Passwords are case-sensitive and must contain at least six characters.

4. Confirm the new password in the Confirm text box.

Modifying User Properties

If you are an administrator, you can modify properties for any user. You can:

• Change a user’s full name, which is used for e-mail purposes.

• Change a user’s password.

• Change a user’s status from non-administrator to administrator or vice versa.

• Force a password change during the user’s next log on attempt.
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To modify user properties:

1. Select the Team tab below the right pane.

The team list appears.

2. Double-click the user.

Or,

Select the user, then select Properties... from the Team menu or context menu.

The User Properties dialog opens.

3. Change the setting for the property.

Deleting Users or Groups

When project security is enabled, only an administrator can delete users or groups.

To delete users or groups:

1. Select the Team tab below the right pane.

The team list appears.

2. Select the users and/or groups to be deleted.

3. Select Team Ö Delete from the menu bar.

Or,

Press Delete.
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Reporting and Charting

You can create charts and reports using Team Ö Reports... and 
Team Ö Charts.... See Chapter 8, “Reporting,” and Chapter 9, “Charting,” for more 
information.
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Chapter 6
Using the Audit Log
The audit log is a chronological record kept by Versions. It accumulates data about 
actions performed on projects, subprojects, files, and users. It appears when you select the 
Audit tab below the right pane.

It lists the entries that are all of the following:

• Attached to the selection from the project tree

• Match the filter selected from the Filter drop-down list box

• Match the depth specified by the selected scope button

The following figure shows all the audit entries attached to the root project, matching the 
filter Only Project Events, and at the No Descendants depth.
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Audit Trail tabs Most property dialogs have an Audit Trail tab that allows yo
to view the log for the selected object. For example, you can
view the entries in the audit log that pertain to a specific 
version—a subset of the entries that are normally displayed
the log for a project, subproject, or file.

Columns The Audit Log contains several columns, each with its own 
column header. The columns are:

Type The type of action:

  Information
Information audit entries are generated for 
each normal project activity, such as adding
a file to a project and checking in a new ver
sion.

  Warning
Warning audit entries are generated for non
critical project activity. For example, 
attempting to check in the file generates a 
warning when your software “touches” a file
to change the date and time stamp, but the
contents of the file are unchanged.

  Error
Error audit entries are generated for critical
abnormal project activity. 

 Event  Name of the action, such as File locked, Us
added, Project modified, or Subproject 
deleted. See “Audit Log Events,” later in this
chapter for more details.

Time Stamp Date and time of the action.

User  Person performing the action.
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Description Description of the action.

Owner Project, subproject, file, version or user 
receiving the action.

SortingClick a column header to sort the displayed entries based on 
the value in that column. Time Stamp sorts from most recent to 
earliest in time. Otherwise, the sort is in ascending order, 
numeric or alphanumeric depending on the data. To change the 
sort order from ascending to descending (or vice versa), click 
the header a second time. Right-click another header to 
perform a secondary sort. The primary sort column’s header is 
underlined.

Group bandsWhen sorting, group bands separate entries with the same 
value in the sort column. When the values of the sorted column 
are likely to be unique, no group bands appear.

MenusAfter selecting one or more entries, use the Audit menu or 
right-click to display a context menu. 

Double-clickDouble-click an entry to see its properties. This shows you the 
contents of the row in a dialog.
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Using Audit Log Filters

Filtering allows you to limit the kinds and quantity of entries to be displayed in the au
log. Select a filter from the Filter drop-down list box above the audit log. What is 
displayed is also affected by your selection from the project tree and the scope butto
The filters are: 

<Show All> Displays all the entries.

Date Range = 1 Month Displays only the entries that were created within th
last month.

Date Range = 1 Week Displays only the entries that were created within th
last week.

Date Range = Last 24 hours Displays only the entries that were created within th
last 24 hours.

Only file events Displays only the entries about actions that were pe
formed on files.

Only project events Displays only the entries about actions that were pe
formed on projects

Only subproject events Displays only the entries about actions that were pe
formed on subprojects.

Only user events Displays only the entries about actions that were pe
formed on the user list.

Type = Error Displays only the entries that record errors.

Type = Information Displays only the entries that record information.

Type = Warning Displays only the entries that record warnings.

User = Me Displays only the entries about actions performed b
the logged on user.
6-4 Versions User’s Guide



 

Audit Log Events

Events are actions performed on an owner. For example, a file can be checked in or
removed from version control. Such events are recorded in the audit log.

Audit events that can be attached to files are:

• File added

• File checked in

• File deleted (working file)

• File locked

• File modified

• File moved

• File purged

• File removed (from project)

• File unlocked

Audit events that can be attached to projects are:

• Build designated

• Label created

• Label deleted

• Milestone designated

• Project created

• Project modified

• Subproject added

• Subproject branched

• Subproject deleted

• Subproject modified

• Subproject moved

• User added

• User deleted
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• User modified

• Group added

• Group deleted

• Group modified

• Security template added

• Security template deleted

• Version modified

• Version deleted

Enabling and Disabling the Audit Log

When security is enabled, only an administrator can enable or disable the collection 
audit information.

To enable or disable auditing:

1. Select the root project from the project tree.

2. Select Properties... from the Project menu or the context menu.

The Project Properties dialog opens.

3. Select the Audit Log check box to continue or clear it to stop adding entries to th
audit log.

Clearing the Audit Log

When project security is enabled, only an administrator can clear the audit log. You m
occasionally want to empty all or part of it.
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To empty the entire audit log:

1. Select the root project from the project tree.

2. Select the Audit tab below the right pane.

The Audit Log appears in the right pane.

3. Select Audit Ö Clear Log... from the menu bar.

The Clear Audit Log dialog opens.

4. Do one of the following:

• To clear the entire log, leave the All option button selected. 

• To delete everything before a certain date, select the As Of option button. 

a. To specify a date, use the calendar (available from the list box), the nex
previous month buttons, and the arrow keys.

b. To specify a time, type the time in the text box, then select the AM or P
option button.
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Sending Audit Entry Descriptions

You can send the text of the descriptions for the selected audit entries as an e-mail 
message using Audit Ö Send To.... See Chapter 7, “Using E-mail with Versions” for 
more information.

Reporting and Charting

You can create a number of charts and reports using Audit Ö Reports... and Audit Ö 
Charts.... See Chapter 8, “Reporting,” and Chapter 9, “Charting,” for more informatio
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Chapter 7
Using E-mail
If you have a MAPI-compliant e-mail system, such as Microsoft Exchange, Versions 
your Versions full name to log on to e-mail and send mail messages. 

You can:

• Send e-mail messages to other team members from within Versions

• Attach versions of files to e-mail messages

• Send the text of audit entries and reports

Versions automatically:

• Sends messages welcoming new users as they are added to Versions

• Notifies the former locker of a file when that file’s lock has been broken

  NOTE
If a user has the same name in multiple address lists (for example, Personal and Glo
Address Lists), Versions uses the first one it finds based on the e-mail application’s 
settings. For Microsoft Exchange users, address settings can be found in Tools Ö 
Options... Ö Addressing. The Addressing property page allows a user to define the or
in which Exchange searches lists when multiple lists are present.
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Enabling or Disabling E-mail

You can only use the mail features described in this chapter if e-mail is enabled for t
project. When project security is enabled, only an administrator can enable or disabl
mail. 

To enable or disable e-mail:

1. Select the project from the project tree.

2. Select Properties... from the Project menu or the context menu.

The Project Properties dialog opens.

3. Select the Defaults tab.

4. Select the Use Mail check box to use your e-mail application from Versions or cle
to stop using e-mail.

If you enable mail, you must close and reopen the project for your change to take eff

Changing a User’s E-mail Name

The full name for a Versions user should be the name that the user uses for e-mail. 
can always change your own full name, but when project security is enabled, only an
administrator can change the full names of other users.
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To change the user’s e-mail name:

1. Select the Team tab below the right pane.

The team list appears.

2. Double-click the user.

Or,

Select the user. Then select Properties... from the Team menu or the context menu

The User Properties dialog opens.

3. Type the new e-mail name in the Full Name text box, then click OK.

Sending Notes to Team Members

You can send a note to one or more team members using Versions.

To send a message:

1. Select Project Ö Send Note To... from the menu bar.

The Send Note To dialog opens. 

2. Select one or more recipients from the Recipient List.

3. Click Goto Mail....

Continue writing the message using your MAPI-compliant e-mail application. 
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Sending File Versions

You can send any file version as an e-mail attachment. When you select files from th
project tree or files list, you sent the most recently checked-in versions. When you se
version from the history list, you send that version, no matter how recent it is.

To send a version as an attachment:

1. Select the name of a file from the project tree.

Or,

Select one or more files from the files list.

Or,

Select a version from the history list.

2. Click Send .

Or,

Select Send To... from the Files menu or a context menu.

The Send To dialog opens.

3. Select one or more project users from the Recipients list. If you don’t select any u
the mail message goes to all of them.

4. Click Send Now to send the message, which has the subject “Files from Version
Project: project name” or “Version from Versions Project: project name” and conta
only the attached file or version.

Or,

Click Goto Mail... to edit the message inside your e-mail application. Then send 
message via that application.
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Sending Audit Entry Descriptions

You can send the text of the descriptions for the selected audit entries as an e-mail 
sage.

To send audit entries via e-mail:

1. Select the name of a project, subproject, or file from the project tree.

2. Select the Audit tab below the right pane.

The audit log appears in the right pane.

3. Select the audit entries to be sent from the audit log.

4. Click Send .

Or,

Select Send To... from the Audit menu or context menu. 

The Send To dialog opens.

5. Select one or more project users from the Recipients list. If you don’t select any
users, the mail message goes to all of them.

6. Click Send Now to send the message, which has the subject “Audit entries from
sions Project: project name” and contains descriptions of the selected entries.

Or,

Click Goto Mail... to edit the message inside your e-mail application. Then send 
message via that application.
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Sending a Report

You can send a report via e-mail as an attached file in a specified format, such as tha
Excel or Lotus 1-2-3 spreadsheet or a Word for Windows document.

To send a report via e-mail:

1. While previewing the report, click Send Report  at the bottom the Preview 
window to export the report.

The Export dialog opens.

2. Select a format from the Format drop-down list box.

3. Make sure that Microsoft Mail (MAPI) appears in the Destination drop-down list b
then click OK.

4. Depending on the selected format, another dialog may open so you can select a
tional options, then click OK.

For example, the Number and Date Format dialog opens when you select Data I
change Format (DIF). On the other hand, if the selected format is Rich Text Form
(RTF), no dialog opens.
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 Finally, the Send Mail dialog opens.

5. Provide addresses, a subject, and an explanatory message, then click Send.

Versions sends the report in the selected format to the addressees.

The report file is given a default name, such as filehist.chr or filesum.chr, depen
on what report you created.
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Chapter 8
Reporting
Versions offers a wide variety of reports for files, versions, users, and audit entries. B
you create a report, limit what is displayed in the right pane to fit that report’s purpos
Then, if appropriate, select only the displayed items you want in the report.

Sorting, grouping, and selecting items in the right pane of the Versions project windo
affects report generation. To produce a report based on a specific sorting or groupin
Versions data, or to produce a report based on a limited or expanded set of objects,
arrange the data in the Versions project window before you generate the report.

For example, a manager might want a report of all the files and their version historie
the entire project. She selects the root subproject from the project tree, the Files tab
Files in Project filter, and the All Descendants scope button. She clicks the header o
Timestamp column to sort the files by date and time. Then she selects Files Ö Reports... 
and File Detail to create a File Detail Report.

A team leader might prefer to see the version histories for the files is a single subpro
He selects the subproject that corresponds to his team from the project tree and cre
File Detail Report much like the manager’s. 

Individual programmers will want to see version histories only for the files they creat
They perform the same process as the team leader, but they sort the files by Author
select only the files that have themselves listed as the Author. Then they use Files Ö 
Reports... to create a File Detail Report.

While these examples all pertain to files, you can also create useful reports about us
and the audit log.
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To create reports:

1. Select Reports... from the Files, History, Team, or Audit menus.

The Reports dialog displays a list of possible reports in the Reports list box and 
description of each report in the Report Description list box.

2. Select a report from the Reports list box.

3. Select the Currently Selected option button in the Report Information group box 
create the report using only the items selected from the right pane. Select the Se
All option button to use all the items displayed in the right pane.

4. Click Preview to review the report.

5. Click Print to print the report.

6. You can repeat steps 2 through 5 to create more reports. Click Close when you 
done.
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The report preview window’s toolbar allows you to:

• Read status information about the number of pages and items included in
report. In the figure above, the items are defects. For example, the report i
figure above contains all 15 (or 100%) of the defects displayed in the defe
list.

Go to the first page

Go to previous page

Go to next page

Go to the last page

Print the report

Write the report to a file

Mail the report
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Zoom in on the report
Switch among two or three of the following views:

• Normal width
You may have to scroll horizontally and vertically to see rest of the pa

• Adjusted width (to fit the page’s complete width in the window)
The adjusted width view is not displayed if the window is large enough
show the page’s complete width in normal width.
You may have to scroll vertically to see the rest of page.

• Adjusted height (to fit the page’s complete height in the window)

Available Reports

You can preview and print a number of different reports, depending on the selected 

Table 1: Available Reports

Tab Name of Report Description of Report

Files File Detail Lists files and their version histories.

File Summary Lists file summary information.

History Version History Lists selected version entries.

Team User List Lists selected user entries as displayed 
in team list

Audit Audit List Lists all audit entries as displayed in the 
audit log.
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Writing a Report to a File

You can also write a report to a disk file in a specified format, such as that of an Exc
Lotus 1-2-3 spreadsheet or of a Word for Windows document.

To write a report to a file:

1. While previewing the report, click Write Report to File  at the bottom the 
Preview window to export the report.

The Export dialog opens.

2. Select a format from the Format drop-down list box.

3. Make sure that Disk File appears in the Destination drop-down list box, then clic
OK.

4. Depending on the selected format, another dialog may open so you can select a
tional options, then click OK.

For example, the Number and Date Format dialog opens when you select Data 
change Format (DIF). On the other hand, if the selected format is Rich Text Form
(RTF), no dialog opens.

 Finally, the Choose Export File dialog opens.

5. Provide a name and path for the disk file, then click Save.

Versions writes the report to the selected file.

Sending a Report

You can send a report via e-mail as an attached file in a specified format, such as th
an Excel or Lotus 1-2-3 spreadsheet or a Word for Windows document. You can sen
report along with an explanatory note to any number of addressees. For more inform
about e-mail, see Chapter 7, “Using E-mail with Versions.”
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Chapter 9
Charting
Versions offers a great variety of charts for files, versions, users, and audit entries. B
you create a chart, limit what is displayed in the right pane to fit that chart’s purpose
Then, if appropriate, select only the displayed items that you want to chart.

Sorting, grouping, and selecting items in the right pane of the Versions project windo
affects chart generation. To produce a chart based on a specific sorting or grouping 
Versions data, or to produce a chart based on a limited or expanded set of files, arran
data in the Versions project window before you generate the chart.

For example, the administrator may want to make sure that the latest version of eve
is checked in and unlocked before he executes a build. He selects the root subprojec
the project tree, the Files tab, the Files in Project filter, and the All Descendants scop
ton. Then he selects Files Ö Charts... and creates a File Lockers chart. This chart show
who still has files locked. 
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To create charts:

1. Select Charts... from the Files, History, Team, or Audit menus.

The Charts dialog displays a list of possible charts in the Charts list box and a de
tion of each chart in the Chart Description list box.

2. Select a chart from the Charts list box.

3. If the Time Series drop-down list box is enabled (as it is for some charts), select
Daily, Weekly, or Monthly as the time period for the charted information.

4. Select the Currently Selected option button in the Chart Information group box to
ate the chart using only the items selected from the right pane. Select the Select
option button to use all the items displayed in the right pane.

5. Click Chart to display the chart.

Once the chart appears, you can use Chart help to change the chart in a variety
ways.

6. You can repeat steps 2 through 5 to create more charts. Click Close when you a
done.
9-2 Versions User’s Guide



f 
Available Charts

You can display a number of different charts, depending on the selected tab.

Table 2: Available Charts

Tab Name of Chart Description of Chart

Files File Authors Pie chart; number of files added to project 
by each user.

File Lockers Pie chart; number of files locked by each 
user.

File Sizes Double series bar chart; compares sizes o
working files (first series) to sizes of 
project vault files (second series).

File Versions Bar chart; number of versions currently 
stored in the vault for each file.

Files in Subprojects Pie chart; number of files in each sub-
project.

History Version Authors Pie chart; number of versions by each 
author.

Version Sizes Line chart; size of each version.

Team Admin Users Pie chart; numbers of administrators and 
non-administrators.

User Types Pie chart; numbers of users and groups.
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The Chart Window

The chart window displays the chart generated from your Versions data. Once you g
ate the chart, you can manipulate it in several ways, copy the chart or the data to the
dows Clipboard, and print the chart.

The chart window, by default, displays a toolbar and a pallet bar. It may, optionally, d
play a pattern bar.

The charting toolbar buttons are:

Import Chart
Open a chart file that has been previously saved to disk.

Export Chart
Save a chart file to disk.

Copy to Clipboard as Bitmap
Copy the chart to the Windows Clipboard as a bitmap.

Audit Audit Entry Events Pie chart; number of entries for each 
event.

Audit Entry Owners Pie chart; number of entries for each 
owner.

Audit Entry Types Pie chart; number of entries for each type
(Information, Warning, and Error).

Audit Entry Users Pie chart; number of entries for each use

Table 2: Available Charts

Tab Name of Chart Description of Chart
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Copy to Clipboard as Text
Copy the chart data to the Windows Clipboard as text. 

Print Chart
Print the chart.

Change Gallery Type
Open a drop-down list box that allows you to change the type of chart (ba
scatter, pie, etc.). The button changes to indicate the current selection.

Change Color
Open a drop-down pallet that allows you to change the active color. The c
can then be dragged to any chart element that accepts color.

Switch between 3D and 2D
Toggle between three-dimensional and two-dimensional charts.

Rotate Chart
Open a dialog that allows you to change the viewing angle and perspective
three-dimensional chart.

Z-Clustered Series
Add depth to a multi-series chart.

Zoom
Enlarge a specific area of the chart.

Show or Hide Legend
Toggle the display of the chart legend on and off.

Show or Hide Series Legend
Toggle the display of the series legend on and off.

Vertical Grid
Toggle the display of a vertical grid on and off.

Horizontal Grid
Toggle the display of a horizontal grid on and off.
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Edit Titles
Edit title text.

Change Text Fonts
Select a font for chart labels and legends.

Tools
Open a drop-down list box that allows you to toggle display elements such a
toolbar, pallet bar, and pattern bar on and off.

Change Chart Options
Open a multi-tab dialog in which you can set chart type and appearance, sc
view, and title text.

Editing Charts

After you generate a chart, you can change its appearance, change the chart data, c
chart as a bitmap or as text, and print the chart.

Changing a Chart Type

Versions generates a chart type appropriate for the selected data. Available chart typ
include pie, bar, scatter, area, surface, and more. You can change the chart type to 
your needs.

To change the chart type:

1. Click Change Gallery Type .

A drop-down value set of possible types opens.

2. Select a chart type.
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Changing Chart Data

Once you generate a chart you can change the data to perform “what if” calculations
fine-tune the chart.

To change the chart data:

1. Click Tools .

The Tools drop-down menu opens.

2. Select Data Editor from the menu bar.

The Data Editor window appears in place of the chart. The Data Editor lists each
value used to create the chart.

3. Edit the values as necessary.

a. Double-click a value to be changed.

The value is highlighted and the alignment changes from right-aligned to lef
aligned.

b. Type the new value.

c. Press tab to move through the data and make changes.

Or,

Double-click another value to be changed.

d. Repeat step c as often as necessary until you are finished editing data.

4. Click Tools .

The Tools drop-down menu opens. There is a checkmark next to the Data Edito
item.

5. Select Data Editor from the menu bar to remove the checkmark from the menu 
close the Data Editor window, and regenerate the chart.
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Changing Chart Color or Pattern

You can change the color of any chart element, including individual slices of a pie ch
bars on a bar chart, chart background, legend background, and so on by dragging co
from either the Change Color toolbar button or the color pallet. You can also drag-an
drop patterns from the pattern bar onto any chart element that accepts color or patte

To change the color of a chart element:

1. Click Change Color .

A drop-down pallet opens.

2. Select a color from the pallet.

The pallet closes and the color on the button changes to reflect your selection.

3. Drag the color from the button to the appropriate chart element.

To display the pallet bar and/or the pattern bar:

1. Click Tools .

A drop-down menu opens. Items on this menu are toggles. Selecting an item wit
a checkmark activates the option and places a checkmark next to the menu item
Selecting the item again deactivates the option and removes the checkmark from
menu bar item.

2. Select Pallet Bar or Pattern Bar to display the element.

Once the pallet bar and/or pattern bar are displayed, you can drag-and-drop a co
pattern onto any chart element that accepts color or patterns (more chart elemen
accept color than patterns).

To remove a pattern from a chart element:

1. Click Change Chart Options .

The Chart Properties tab dialog opens with the General tab selected.

2. Click Color Scheme .
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A drop-down value set opens. Color scheme options are:

  Solid color

  Black and White pattern

  Color pattern

3. Select Solid Color to remove any previously applied patterns, then click Apply.

Changing Chart Text

Versions automatically provides a top title and a legend for your chart. You may also
vide left, right, and bottom titles, edit the title or legend text, and change text fonts fo
each text element on the chart.

To change the legend text:

1. Click Tools .

The Tools drop-down menu opens.

2. Select Data Editor from the menu bar.

The Data Editor window appears in place of the chart. The Data Editor lists each
value used to create the chart.

3. Edit the legend text as necessary.

a. Double-click on a text element to be changed.

The text is highlighted.

b. Type the new text.

c. Repeat steps a and b as often as necessary until you are finished editing da

4. Click Tools .
Charting 9-9
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The Tools drop-down menu opens. There is a checkmark next to the Data Editor

5. Select Data Editor from the menu bar to remove the checkmark from the menu b
close the Data Editor window, and regenerate the chart.

To add or change title text:

1. Click Edit Titles .

The Titles dialog opens.

2. Type the title text (or edit the existing text) for top, bottom, left, and/or right titles

3. Click Apply to view your changes before closing the dialog or click OK.

To change font or color for any text element:

1. Click Change Text Fonts .

A drop-down menu listing all available text elements opens.

2. Select the text element for which to change fonts.

A standard Font dialog opens.

3. Make changes to the font, style, point size, emphasis, and/or color, as appropria

Changing Viewing Options for 3D Charts

You can view charts in two dimensions (2D), three dimensions (3D), or full 3D view. 
full 3D view, you can tilt and swivel the chart.

To switch between 2D and 3D:

• Click Switch Between 2D and 3D Views . 
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To tilt and swivel a 3D chart:

1. Click Rotate Chart .

The 3D View Properties dialog opens.

2. Select the Full 3D View check box, if necessary, to activate full three-dimension
viewing options.

3. Using the mouse, drag the blue dot around the x-axis plane and/or drag the red
around the y-axis plane.

Exploding a Pie Chart

To emphasize one or more values, a pie chart is frequently “exploded.” That is, one 
more slices of the pie are shown separated from the rest.

To explode a pie chart:

1. Click on the slice to be separated from the rest of the pie.

The mouse pointer changes to a cross.

2. Drag the slice away from the center of the pie chart.
Charting 9-11
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Chapter 10
Setting Workstation Options
Versions allows you and your team members to set workstation options that suit you
individual work styles.

To customize Versions:

1. Select Options Ö Workstation... from the menu bar.

The Workstation Options dialog opens.

2. Use the Confirm tab to:

• Confirm deletions, moves, and overwrites.

• Display warnings.
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3. Use the Defaults tab to:

• Set up version control so that:

- Files you check out are locked automatically.

- Files you check in retain their locks.

- Working files are deleted as you check in new versions.

- Working files that are not locked by you become read-only as you check
them out. Working files that you unlock become read-only as well.

• Allow double-clicking to edit rather than execute .bat and .cmd files.

4. Use the Display tab to:

• Automatically revert to the No Descendants scope button every time you cha
a tab or subproject. This saves you the time Versions would take to scan files
10-2 Versions User’s Guide
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so forth. Clear this check box so that only you change the scope buttons.

• Restore projects that were open when you last closed Versions.

• Display or hide the following:

- Splash screen

- Toolbar

- Status bar

• Control the automatic refresh rate. Set a number of minutes from 1 to 90. To
refreshing, use 0.

5. Use the Tools tab to:

• Designate a text editor or word processor to be used when you double-click
files. The default editor is Windows NotePad.
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Chapter 11
Maintaining Projects
As with all databases, the more you use project database files (especially for deletio
the more need there is to perform maintenance on them.

To start Project Maintenance:

• Double-click the Project Maintenance icon in the Versions program group.

Or,

Select Project Maintenance from the taskbar. By default, this would be Start Ö 
Programs Ö Versions Ö Project Maintenance.

The Project Maintenance window opens.

The window has both a toolbar and a status bar. You can enable or disable them
View Ö Toolbar and View Ö Status Bar. A checkmark appears in front of the men
item when the corresponding bar is enabled and disappears when the bar is dis

Repairing the Database

Use Repair when you cannot open the project database file, and the error “Unrecog
database format” is returned. Project Maintenance uses the database engine’s repa
facility to fix the problem, but, depending on the file’s level of corruption, it may be 
unsuccessful.
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To repair certain types of file corruption:

1. Select Project Ö Repair... from the menu bar.

The Open dialog appears.

2. Select the project database file (.stp) to be repaired then click Open.

Packing the Database

As you delete the records for files, versions, and subprojects from a Versions projec
space they occupied needs to be reclaimed. Use the Pack command to eliminate spa
is no longer used and to reduce the size of the project database file. 

To pack the database:

1. Select Project Ö Open... from the menu bar.

The Open dialog appears.

2. Select the project database file (.stp), then click Open.

A project database window opens. Its title is the file you selected.

3. Select Project Ö Pack from the menu bar.

Project Maintenance packs the project database file, eliminating the space forme
allocated to records that are now deleted. It also redisplays statistics in the wind
11-2 Versions User’s Guide
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Validating the Database

Validating a database checks it for inconsistencies and verifies that project data 
relationships are in order. For example, if a subproject is supposed to have a child 
subproject, the validation checks to see if the child subproject really does exist. Prob
with relationships may occur if the project suddenly shuts down in the middle of a cri
operation.

To validate the database:

1. Select Project Ö Open... from the menu bar.

The Open dialog appears.

2. Select a project database file (.stp), then click Open.

A project database window opens. Its title is the file you selected.

3. Select Project Ö Validate from the menu bar.

Project Maintenance validates the data in the project database file. It also redisp
statistics in the window.

Viewing the Log

When you use Project Maintenance commands to perform actions on a project data
file (.stp), Project Maintenance logs those actions and the times at which they occur
log file is a text file that has the same name as the project database file. However, it
extension is .log.

To view the log:

1. Select Project Ö Open... from the menu bar.

The Open dialog appears.
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2. Select a project database file (.stp), then click Open.

A project database window opens. Its title is the file you selected.

3. Select Project Ö View Log from the menu bar.

Project Maintenance displays the log in Windows NotePad.
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Chapter 12
Using Visual Diff
Visual Diff is a text comparison utility that is integrated into Versions. Using Visual D
you can quickly compare two different versions of a text file or two similar text files.

To access Visual Diff as a stand-alone utility:

1. Double-click the Visual Diff icon in the Versions program group.

Or,

Select Visual Diff  from the taskbar. By default, this would be Start Ö Programs Ö 
Versions Ö Visual Diff .

The Visual Diff window opens.

2. Select File Ö Open... from the menu bar.

Or,

Click Open .

The Select First File dialog opens.

3. Select the first text file to compare then click Open.

The Select Second File dialog opens.

4. Select the second file to compare then click Open.

Visual Diff compares the files and displays them in the Visual Diff main window.

  NOTE
Visual Diff cannot compare files which exceed 32,768 lines of text.
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Using the Visual Diff Main Window

The Visual Diff main window consists of a menu bar, a tool bar, and an application 
workspace in which it displays the two files or versions being compared. You can dis
the compared files in two separate panes, either side-by-side or one on top of the oth
in merged view in a single-pane window.

Manipulating the Window Splitter Bars with the Mouse

In addition to using the Window menu options and the toolbar buttons to change the
display options for the files, you can also manipulate the splitter bar with the mouse.
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When in use, the splitter bar divides the Visual Diff main window. When not in use, t
horizontal splitter bar is located above the vertical scroll bar and the vertical splitter b
located to the left of the horizontal scroll bar.

Possible mouse operations include:

• Drag the splitter bar that separates the two panes to reproportion those panes.

• Drag the splitter bar that separates two panes to a window edge to remove the s
and show the files together in a single pane.

• Drag the vertical splitter bar onto a window that is not split or is split horizontally
split the window vertically.

• Drag the horizontal splitter bar onto a window that is not split or is split vertically
split the window horizontally.

• Double-click on a splitter bar that is not in use to activate it.

• Double-click on a splitter bar that is in use to deactivate (remove) it.

   Horizontal Splitter Bar

Vertical Splitter Bar
Using Visual Diff 12-3
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Comparing Files and Viewing Differences

Whether you launch Visual Diff from within Versions or open it as a stand-alone app
tion, Visual Diff automatically compares the two files or versions as soon as you iden
them. The first file that you select appears on the left, and the second file appears on
right. If you access Visual Diff from within Versions to compare two versions of the sa
file, the older file is on the left and the newer file is on the right.

If there are no differences between the files, Visual Diff displays a message stating th
files are the same and does not display them.

Once Visual Diff compares and displays the files, the differences are shown in color.
default colors are as follows:

Black
Matching lines are displayed in black.

Red
Deleted lines appear in red and struck through. Deleted text is text contained in the f
the left only.

Green
Inserted lines appear in green. Inserted text is text contained in the file on the right o

Blue
Changed lines appear in blue. Lines that are similar but not identical are considered 
changed.

When the compared files are shown in a single pane, matching, deleted, and inserte
are shown only once in their appropriate color. Changed lines appear twice (in blue)
first line is from the file selected first or the older version and is struck through. The 
second line is from the file selected second or the newer version.

To change the colors for matching, deleted, inserted, and/or changed text:

1. Select Options Ö Workstation  from the menu bar.

2. Select the Color tab.

3. Select the kind of text to be changed from the list, then click Select Color....
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4. Select one of the predefined colors or click Define Custom Colors>> and define 
color to use for the text element using the standard Windows color dialog.

To return to the default Visual Diff colors:

1. Select Options Ö Workstation  from the menu bar.

2. Select the Color tab.

3. Click Default Colors.

Searching for Text

You can locate text strings in the active pane.

To find text:

1. Select Search Ö Find... from the menu bar.

Or,

Click Find . 

The Find dialog opens.

2. Type the string to be located in the Find What text box.

3. If you want to locate the text exactly as you typed it with regard to case, select th
Match Case check box.

4. If necessary, specify a direction for the search.

Visual Diff remembers the search string until you enter another search string or 
you close the application. To locate the next instance of the text, use the Find N
option. (Change panes if you want to search the other pane.)
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You can also search for the next set of matching or non-matching lines or the previou
of matching or non-matching lines using the Search menu or the toolbar buttons. Vis
Diff locates the lines and positions them at the top of the panes.

Merging or Printing Compared Files

When you merge two files or versions to create a new file, the system uses a series 
characters to delineate text rather than using colors. Once the files are merged, you 
delete extraneous text manually.

Key to Reading Merged File:

####### Separates changed lines from the rest of the text. Both versions of the 
changed lines are shown, separated by ~~~~~~~ .

------- Separates deleted lines from the rest of the text

+++++++ Separates inserted lines from the rest of the text
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Below is an example of a merged file.

@ECHO OFF
C:\WINDOWS\NET START
######################### 1 Line(s) Changed ##########
C:\DOS\SMARTDRV.EXE /X
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
C:\DOS\SMARTDRV.EXE 1024 /X
###################################################
PROMPT $p$g
PATH c:\windows;c:\dos;c:\mach32
----------- 1 Line(s) Deleted ---------------------
SET DIRCMD=/oen
---------------------------------------------------
REM Set location for temp files.
######################### 1 Line(s) Changed ##########
SET TEMP=C:\DOS
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
SET TEMP=C:\TEMP
###################################################
+++++++++++++++++++++++++ 1 Line(s) Inserted +++++++++
SET TMP=C:\TEMP
+++++++++++++++++++++++++++++++++++++++++++++++++

To merge compared files:

1. Open and compare the files.

2. Select File Ö Merge Files... from the menu bar.

Or,

Click Merge .

The Save Merged Comparison As dialog opens.

3. Select a directory in which to store the file, name the file, and click Save.

Visual Diff creates the new file and, if the editing option is set, opens it in Windo
NotePad or the text editor of your choice.
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Setting Options

You can customize Visual Diff to suit your individual preferences and work style by 
setting display, comparison, merge, and color options.

To customize Visual Diff:

1. Select Options Ö Workstation... from the menu bar.

The Options dialog opens. 

2. Select one of the tabs at the top of the dialog.

• Select Display to change the display of text in the compared files or versions.
You can change the font and tab settings, display only the differences, and t
line numbers on or off. 

You also use this option to turn off the Visual Diff splash screen which appea
start up and display or hide the toolbar and status bar.

• Select Compare to set case and whitespace options during a search.

• Select Merge to determine when to view a merged file and with what editor.

• Select Color to change the default colors for deleted, changed, inserted, and
matching text.
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Chapter 13
Using the Command-line 
Interface
You can perform the following operations from a command-line session using the co
mand stcmd and the appropriate options. These commands also allow you to perform
sions’s version control operations from any development environment that allows yo
add tools to menus.

• Add files (stcmd add)

• Check in files (stcmd ci)

• Check out files (stcmd co)

• Lock or unlock files (stcmd lck)

• Compress or decompress files (stcmd cmp)

• Merge files (stcmd mrg)

• Designate build (stcmd dbd)

• Designate milestone (stcmd dms)

• Change description (stcmd dsc)

• Set maximum number of versions (stcmd mnv)

• Give versions permanent or non-permanent status (stcmd prm)

• Delete versions (stcmd dvr)

• Purge non-permanent versions (stcmd prg)
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Use /? to display the options available with the command. 

For example, stcmd /? displays the general syntax for stcmd and stcmd add /? displays 
the options available when adding files. (Using stcmd and stcmd add without the /? a
works.)

Syntax

The syntax for the command line uses the following conventions:

Bold Information that you must use exactly as shown (if you use it).

Italics Information that you replace with the names of your files, subprojects, e

[     ] Optional information appears in square brackets.

Common Parameters

Some parameters show up in all or almost all of the commands explained in this cha
In each command, they have exactly the same meaning so they are explained in this
tion and not repeated later. Parameters that do not appear in all commands or vary i
meaning from command to command are explained with the commands.

/p Indicates what project is to be used by providing one of the following:

• The name of the project database file for the project. Use the complete 
name to the file and the .stp extension in double quotation marks. For e
ple, “c:\stardraw.stp”.·

• The server description and project name combination. Separate the two
a colon and delimit them with double quotation marks. For example, 
“Orion:NEF”, where Orion is the server name and NEF is the name of th
project. These are case insensitive.
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/s Provides the name of the subproject, preceded by the names of any other s
projects that separate it from the root subproject. (Do not include the name o
root.) The names of each subproject in the “path” are separated by exclama
points (!) and the complete string is enclosed in double quotation marks. Wh
s is not used, the files are assumed to be in or intended for the root subproj

/is Applies the command to one of the following:

• All the subprojects which are children of the subproject specified with the
option

• All the subprojects in the project when the /s option is not used

/un Provides the name of the user performing the action in double quotation ma
Without this option, the current network logon name is used.

/pw Provides the password (in double quotation marks) for the user specified with
/un option. This option is required only when project security is enabled and
password is not blank.

/q Suppresses progress reporting. Without this option, messages about each a
appear on the screen as the action is performed.

/x Bypasses error messages. Without this option, you will have to confirm erro
messages.

files... Specifies the files to be used in the command by name or by file specificatio
(such as *.c). Without this option, the default is *.*. This must always be the l
parameter. Any parameters after it are ignored. File specifications that inclu
spaces must be delimited by double quotation marks.
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Adding Files: stcmd add

Use stcmd add to add files to a project from the command line.

Syntax

stcmd add  [ /p  ” projFile.stp ”  | “ serverDesc:projName ” ]  
[ /s  “ subproj1!subproj2!... ” ]  [ /is ] [ /un  “ userName ” ]  
[ /pw  “ password ” ]  [ /q ]  [ /x ]  [ /l | /u  [ /ro ]]  
[ /d “ fileDescription ” ]  [ /vl “ versionLabel ” ]  [ /k ]  
[ /md  maxDelta ]  [ /mo  maxOmega]  [ /fo ]  [ files... ] 

/l Locks the files (or keeps them locked) after this action is performed. The loc
is the user specified with the /un option. When neither /l nor /u is specified, V
sions leaves the lock status of each file as it was before the command was e
cuted. When neither /l nor /u are used, the files are locked by default.

/u Unlocks the files (or leaves them unlocked) after this action is performed. W
neither /l nor /u is specified, Versions leaves the lock status of each file as it
before the command was executed.

/ro Used with /u to make the unlocked working file read-only after this operation
completed. Without this option, the file is read/write. Use /ro to make it less 
likely that you will edit a file that is not locked by you.

/d Sets the description for the specified files to the specified description. The 
description is enclosed in double quotation marks.

/vl Provides a version label. The label is enclosed in double quotation marks.

When adding files, this label becomes the label for the versions of the files. 
Without this option, the versions are added to the project without labels.

/k Makes the version being added a permanent version. Without this option, the
sion is non-permanent.
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/md Specifies the maximum number of versions to be stored for the files using d
storage. Without this option, the maximum number is Maximum.

/mo Specifies the maximum number of versions to be stored for the files using om
storage. Without this option, the maximum number is 10.

/fo Forces text files to be stored using omega storage. Without this option, delta
age is used for text files. (Binary files are always stored using omega storag
regardless of this option.) Once a text file has been stored using omega stora
will always be stored using omega storage.

Example

The following example uses stcmd add to add .doc files to a subproject of StarDraw c
User Manual. It locks the files and gives them the description “First draft of chapter”.

stcmd add /p “c:\stardraw.stp” /s “User Manual” /un “NAllis” 
/pw “password” /l /d “First draft of chapter” *.doc

Checking in Files: stcmd ci

Use stcmd ci to check in project files from the command line. 

Syntax

stcmd ci [  /p ” projFile.stp ”  | “ serverDesc:projName ” ]  
[ /s  “ subproj1!subproj2!... ” ]  [ /is ]  [ /un “ userName ” ]  
[ /pw “ password ” ]  [ /q ]  [ /x ]  [ /l  | /u  [ /ro ]] 
[ /vl “ versionLabel ” ]  [ /k ]  [ /f NCI ]  [ /o ]  [ /fo ]  
[ /r “ reasonCheckIn ” ]  [ files... ]
Using the Command-line Interface 13-5
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/l Locks the files after this action is performed. The locker is the user specified w
the /un option. When neither /l nor /u is specified, Versions leaves the lock st
of each file as it was before the command was executed.

/u Unlocks the files (or leaves them unlocked) after this action is performed. W
neither /l nor /u is specified, Versions leaves the lock status of each file as it 
before the command was executed.

/ro Used with /u to make the unlocked working file read-only after this operation
completed. Without this option, the file is read/write. Use /ro to make it less 
likely that you will edit a file that is not locked by you.

/vl Provides a version label. The label is enclosed in double quotation marks.

When checking in files, this label becomes the label for the versions of the fi
Without this option, the versions are checked in without labels.

/k Makes the version being checked in a permanent version. Without this optio
the version is non-permanent.

/f NCI Specifies the check in of all the files that need to be checked in (i.e., all the f
that match the “Files to Check In” filter). When you use this option, any file sp
ifications at the end of the command are ignored. When neither /f NCI nor File
is used, the default is *.*.

/o Allows you to check in files that are identical to the most recently checked in 
sions.

Without this option, identical files are not processed, and an error occurs.

/fo Forces text files to be stored using omega storage. Without this option, delta
age is used for text files. (Binary files are always stored using omega storage
regardless of this option.) Once a text file has been stored using omega stora
will always be stored using omega storage.

/r Provides a reason for checking in the files. The reason is enclosed in double
tation marks. Without this option, no reason is stored for the checked-in vers
13-6 Versions User’s Guide
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Example

The following example uses stcmd ci to check in .bmp files to a subproject called On
Help. On-line Help is a subproject of SourceCode, which is a subproject of StarDraw.
command unlocks the files, makes the working copy read-only, and gives them a re
for check in.

stcmd ci /p “c:\stardraw.stp” /s “SourceCode!On-line Help” 
/un “NAllis” /pw “password” /u /ro /r “revised for beta” 
*.bmp

Compressing and Decompressing Files: 
stcmd cmp

Use stcmd cmp to compress or decompress project vault files from the command lin

Syntax

stcmd cmp  [  /p ” projFile.stp ”  | “ serverDesc:projName ” ]  
[ /s  “ subproj1!subproj2!... ” ]  [ /is ]  [ /un “ userName ” ]  
[ /pw “ password ” ]  [ /q ]  [ /x ]  [ /c  | /dc ]  [ files... ] 

/c Compresses the files.

/dc Decompresses the files.
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Example

The following example uses stcmd cmp to compress all the project vault files in Sour
Code, a subproject in the project StarDraw, as well as all the files in subprojects of 
SourceCode.

stcmd cmp /p “c:\stardraw.stp” /s “SourceCode” /is 
/un “NAllis” /pw “password” /c *.*

Checking Out Files: stcmd co

Use stcmd co to check out project files from the command line.

Syntax

stcmd co  [  /p ” projFile.stp ”  | “ serverDesc:projName ” ]  
[ /s  “ subproj1!subproj2!... ” ]  [ /is ]  [ /un “ userName ” ]  
[ /pw “ password ” ]  [ /q ]  [ /x ]  [ /l  | /u  [ /ro ]]  
[ /vn  versionNumber  | /vl  “ versionLabel ”  | /vd  asOfDateTime ]  
[ /f  NCO]  [ /o ]  [ /ts ]  [ files... ] 

/l Locks the files (or keeps them locked) after this action is performed. The loc
is the user specified with the /un option. When neither /l nor /u is specified, V
sions leaves the lock status of each file as it was before the command was e
cuted.

/u Unlocks the files (or leaves them unlocked) after this action is performed. W
neither /l nor /u is specified, Versions leaves the lock status of each file as it 
before the command was executed.

/ro Used with /u to make the unlocked working file read-only after this operation
completed. Without this option, the file is read/write. Use /ro to make it less 
likely that you will edit a file that is not locked for you.
13-8 Versions User’s Guide
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/vn Specifies the version number to be checked out for each of the files specifie
this command. Without this option or /vl or /vd, the most recent version of th
file is checked out.

/vl Provides a version label. The label is enclosed in double quotation marks.

The label is used to identify the versions to be checked out. Without this opt
or /vn or /vd, the most recent version of the file is checked out.

/vd Specifies a date and optionally a time to be used to identify versions of the s
ified files. The last version checked in before the specified date is the versio
checked out for each file.

The date can be specified as mm/dd/yy or mm/dd/yyyy. The time can be sp
fied in hours; hours and minutes; or hours, minutes, and seconds (separate
colons). The syntax for the time is:  [hh [:mm [:ss]]]

When specifying both a date and a time, separate them with a space and us
ble quotation marks as in “11/13/96 12:01:01”.

Without this option or /vl or /vn, the most recent version of the file is checked
out.

/f NCO Specifies the check out of all the files that need to be checked out (i.e., all th
files that match the “Files to Check Out” filter). When you use this option, an
file specifications at the end of the command are ignored. When neither /f N
nor Files... is used, the default is *.*.

/o When checking out files, forces the check out when the working file appears
be more recent.

Without this option, more recent working files are not processed, and an err
occurs.

/ts Sets each working file´s time stamp to the check-out time. Without this optio
the time stamp is the same as for the checked in version that is being copie
the working directory.
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Example

The following example uses stcmd co to lock and check out .doc files from a subproje
StarDraw called User Manual. 

stcmd co /p “c:\stardraw.stp” /s “User Manual” /un “NAllis” 
/pw “password” /l *.doc

Designating Builds: stcmd dbd

Use stcmd dbd to designate a project build from the command line. A build includes 
the files in the project.

When project security is enabled, only an administrator can designate a build.

Syntax

stcmd dbd  [  /p ” projFile.stp ”  | “ serverDesc:projName ” ]  
[ /un “ userName ” ]  [ /pw “ password ” ]  [ /q ]  [ /x ]  
/nl “ buildLabel ”   [ /vd  asOfDateTime ]

/nl Specifies the build label. The label is enclosed in double quotation marks. Th
option is required.

/vd Specifies a date and optionally a time to be used to identify the versions to b
included in the build. The last version checked in before the specified date is
version used for each file.

The date can be specified as mm/dd/yy or mm/dd/yyyy. The time can be spec
in hours; hours and minutes; or hours, minutes, and seconds (separated by 
colons). The syntax for the time is:  [hh [:mm [:ss]]]
13-10 Versions User’s Guide
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When specifying both a date and a time, separate them with a space and us
ble quotation marks as in “11/13/96 12:01:01”.

Without this option, the most recent versions of the files are included.

Example

The following example uses stcmd dbd to designate as a build the most recent versi
all the files in the project StarDraw.

stcmd dbd /p “c:\stardraw.stp” /un “NAllis” /pw “password” 
/nl “Build 14”

Designating Milestones: stcmd dms

Use stcmd dms to designate a project milestone from the command line. A mileston
includes all the files in the project.

When project security is enabled, only an administrator can designate a milestone.

Syntax

stcmd dms  [  /p ” projFile.stp ”  | “ serverDesc:projName ” ]  
[ /un “ userName ” ]  [ /pw “ password ” ]  [ /q ]  [ /x ]  
/nl “ milestoneLabel ”   [ /vl “ buildLabel ”  | /vd  asOfDateTime ]

/nl Specifies the milestone label. The label is enclosed in double quotation mar
This option is required.
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/vl Provides a build label. The label is enclosed in double quotation marks.

The label is used to identify the versions to be included in the milestone. With
this option or /vd, the most recent versions of the files are included.

/vd Specifies a date and optionally a time to be used to identify the versions to b
included in the milestone. The last version checked in before the specified da
the version used for each file.

The date can be specified as mm/dd/yy or mm/dd/yyyy. The time can be spec
in hours; hours and minutes; or hours, minutes, and seconds (separated by 
colons). The syntax for the time is:  [hh [:mm [:ss]]]

When specifying both a date and a time, separate them with a space and us
ble quotation marks as in “11/13/96 12:01:01”.

Without this option or /vl, the most recent versions of the files are included.

Example

The following example uses stcmd dms to designate as a milestone the most recent
sions of all the files in the project StarDraw.

stcmd dms /p “c:\stardraw.stp” /un “NAllis” /pw “password” 
/nl “Beta”

Changing Descriptions: stcmd dsc

Use stcmd dsc to change a file description from the command line.
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stcmd dsc  [  /p ” projFile.stp ”  | “ serverDesc:projName ” ]  
[ /s  “ subproj1!subproj2!... ” ]  [ /is ]  [ /un “ userName ” ]  
[ /pw “ password ” ]  [ /q ]  [ /x ] /d “ newDescription ”   [ files... ] 

/d Provides a description for the files. The description is enclosed in double qu
tion marks. Without this option, an error message occurs.

Example

The following example uses stcmd dsc to change the description of stdafx.cpp in So
Code, a subproject in the project StarDraw.

stcmd dsc /p “c:\stardraw.stp” /s “SourceCode” /un “NAllis” 
/pw “password” /d “Source code for Project” stdafx.cpp

Deleting Versions: stcmd dvr

Use stcmd dvr to delete versions of project files from the command line. 

When project security is enabled, only an administrator can delete versions.

Syntax

stcmd dvr  [  /p ” projFile.stp ”  | “ serverDesc:projName ” ]  
[ /s  “ subproj1!subproj2!... ” ]  [ /is ]  [ /un “ userName ” ]  
[ /pw “ password ” ]  [ /q ]  [ /x ]  [ /o ] 
[ /vn  versionNumber  | /vl “ versionLabel ” ][ files... ]
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/o Forces the specified versions to be deleted even if they are permanent. In a
tion, you must confirm all the deletions of permanent files.

Without this option, only nonpermanent versions are deleted.

/vn Specifies the version number to be deleted for each of the files specified by 
command. Without this option or /vl, the most recent version of the file is 
deleted.

/vl Provides a version label. The label is enclosed in double quotation marks. T
label identifies the versions to be deleted. Without this option or /vn, the mos
recent version of the file is deleted.

Example

The following example uses stcmd dvr to delete the most recent versions of all the fil
SourceCode, a subproject in the project StarDraw, as well as all the files in subproje
SourceCode.

stcmd dvr /p “c:\stardraw.stp” /s “SourceCode” /is 
/un “NAllis” /pw “password” *.*

Locking and Unlocking Files: stcmd lck

Use stcmd lck to lock or unlock project files from the command line.
13-14 Versions User’s Guide



 is 

oject 

-

Syntax

stcmd lck  [  /p ” projFile.stp ”  | “ serverDesc:projName ” ]  
[ /s  “ subproj1!subproj2!... ” ]  [ /is ]  [ /un “ userName ” ]  
[ /pw “ password ” ]  [ /q ]  [ /x ]  [ /l  | /u  [ /ro ] ]  [ files... ] 

/l Locks the files.

/u Unlocks the files.

/ro Used with /u to make the unlocked working file read-only after this operation
completed. Without this option, the file is read/write. Use /ro to make it less 
likely that you will edit a file that is not locked by you.

Example

The following example uses stcmd lck to unlock all the files in SourceCode, a subpr
in the project StarDraw, as well as all the files in subprojects of SourceCode.

stcmd lck /p “c:\stardraw.stp” /s “SourceCode” /is 
/un “NAllis” /pw “password” /u *.*

Setting Maximum Numbers of Versions: 
stcmd mnv

Use stcmd mnv to set the maximum number of versions for project files from the com
mand line. 

When project security is enabled, only an administrator can set these maximums.
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Syntax

stcmd mnv  [  /p ” projFile.stp ”  | “ serverDesc:projName ” ]  
[ /s  “ subproj1!subproj2!... ” ]  [ /is ]  [ /un “ userName ” ]  
[ /pw “ password ” ]  [ /q ]  [ /x ]  [ /md maxDelta ] [ /mo  maxOmega]  
[f iles... ] 

/md Specifies the maximum number of versions to be stored for the files using de
storage. /md and/or /mo must be used in this command. You can use both, b
you cannot use neither.

/mo Specifies the maximum number of versions to be stored for the files using om
storage. See /md for more information.

Example

The following example uses stcmd mnv to set the maximum number of versions to 2
delta files in SourceCode, a subproject in the project StarDraw, as well as all the file
subprojects of SourceCode.

stcmd mnv /p “c:\stardraw.stp” /s “SourceCode” /is 
/un “NAllis” /pw “password” /md 20 *.*

Merging Files: stcmd mrg

Use stcmd mrg to merge one or more files from a branch subproject back into its roo
project. For each file, Versions performs a three-way merge and copies the resulting 
the working directory for the root subproject, overwriting the working file that is there
The three file versions that are merged are:·

• The latest checked-in version of the specified file in the branch subproject·

• The latest checked-in version of the file in the root subproject that corresponds t
file in the branch·
13-16 Versions User’s Guide
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• The version of the file in the root subproject from which the file in the branch wa
derived

When you branch a subproject, the latest version of each file in the root subproject is
ied to the branch. Initially these two files are identical. However, both can be checke
and out and have their contents modified. Eventually they are simply two files with th
same name and the same parent version (the version of the file originally copied from
root subproject to the branch). Merging these three versions incorporates all the cha
made in the root and the branch subproject. You can edit the merged file and then ch
in to the root subproject.

Syntax

stcmd mrg  [  /p ” projFile.stp ”  | “ serverDesc:projName ” ]  
[ /s  “ subproj1!subproj2!... ” ] [/is] [ /un “ userName ” ]  
[ /pw “ password ” ]  [/q]  [/x]  [files...] 

Example

The following example uses stcmd mrg to merge the file ipframe.cpp from the branc
subproject SourceCode RSL with its “sister file” in the root subproject SourceCode. 
sions knows that the SourceCode RSL subproject was branched from SourceCode a
as what version of ipframe.cpp in SourceCode became the first version of ipframe.cp
SourceCode RSL. Versions merges the current versions of ipframe.cpp found in bot
root and branch subproject with the parent version from the root subproject. The res
are copied to the working directory for SourceCode as the working file ipframe.cpp.

stcmd mrg /p “c:\stardraw.stp” /s “SourceCode RSL” /un “NAl-
lis” /pw “password” ipframe.cpp
Using the Command-line Interface 13-17
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Changing Version Status: stcmd prm

Use stcmd prm to make the specified file versions permanent or non-permanent. 

Syntax

stcmd prm  [  /p ” projFile.stp ”  | “ serverDesc:projName ” ]  
[ /s  “ subproj1!subproj2!... ” ]  [ /is ]  [ /un “ userName ” ]  
[ /pw “ password ” ]  [ /q ]  [ /x ] 
[ /vn  versionNumber  |  /vl “ versionLabel ”  | /vd  asOfDateTime ] 
[ /k ]  [ files... ] 

/vn Specifies the version number to be used for each of the files specified by thi
command. Without this option or /vl or /vd, the most recent version of the file
used.

/vl Provides a version label. The label is enclosed in double quotation marks.

The label is used to identify the versions to be used. Without this option or /v
/vd, the most recent version of the file is used.

/vd Specifies a date and optionally a time to be used to identify versions of the s
fied files. The last version checked in before the specified date is the version 
for each file.

The date can be specified as mm/dd/yy or mm/dd/yyyy. The time can be spe
fied in hours; hours and minutes; or hours, minutes, and seconds (separated
colons). The syntax for the time is:  [hh [:mm [:ss]]]

When specifying both a date and a time, separate them with a space and us
ble quotation marks as in “11/13/96 12:01:01”.

Without this option or /vl or /vn, the most recent version of the file is used.

/k Makes the specified versions permanent versions. Without this option, the v
sion becomes non-permanent.
13-18 Versions User’s Guide
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Example

The following example uses stcmd prm to make permanent the most recent versions
the files in SourceCode, a subproject in the project StarDraw, as well as all the files 
subprojects of SourceCode.

stcmd prm /p “c:\stardraw.stp” /s “SourceCode” /is /un “NAl-
lis” /pw “password” /k *.*

Purging Versions from Files: stcmd prg

Use stcmd prg to purge nonpermanent file versions from the command line.

When project security is enabled, only an administrator can purge files.

Syntax

stcmd prg  [  /p ” projFile.stp ”  | “ serverDesc:projName ” ]  
[ /s  “ subproj1!subproj2!... ” ]  [ /is ]  [ /un “ userName ” ]  
[ /pw “ password ” ]  [ /q ]  [ /x ]  [ files... ] 

Example

The following example uses stcmd prg to purge all the non-permanent versions of the
in SourceCode, a subproject in the project StarDraw, as well as all the non-permane
sions of the files in subprojects of SourceCode.

stcmd prg /p “c:\stardraw.stp” /s “SourceCode” /is 
/un “NAllis” /pw “password” *.*
Using the Command-line Interface 13-19
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Chapter 14
Importing Projects from PVCS
Versions can import projects from the PVCS 32-bit edition of 5.2.1, allowing you to 
update your current project development environment to Versions while maintaining
version history information.

The PVCS Import tool is a stand-alone executable, pvcsimp.exe. It locates a PVCS 
installation by looking for PVCS’s islv.ini file in your Windows directory (for example,
c:\windows\islv.ini). It displays a list of projects from the .ini file and allows you to 
import projects into Versions. Importing PVCS projects does not alter or delete those
PVCS projects. The import process only copies information from them into Versions
databases and vaults, creating Versions projects.

PVCS Import Features
• Reads the PVCS project information and allows you to select PVCS projects for

import. 

• Maps PVCS folders to Versions subprojects.

• Imports all or only the last revision of the main trunk of all archives.

• Imports all check-in information such as author, (original) date of check-in, versi
comment, labels, etc.

• Reports all actions performed during the import online in the Versions PVCS Imp
dialog and logs the actions in a log file as well.

• If you cancel the import after it starts, the partially constructed project is deleted.
are all the vault files and databases. The directory structure is left unchanged. T
original PVCS files are left undeleted.
Importing Projects from PVCS 14-1
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Limitations and Differences
• Imports projects from the PVCS 32-bit edition of 5.2.1 only.

• Does not support multiple references to a vault (archive) file. When the Project Fo
and other user-created PVCS folders contain the same file, that file is imported a
part of only one of those user-created folders.

• Does not support PVCS branches. Only the main trunk is imported. Ignored bran
are not reported in the log file.

• Does not import promotion definitions or private folders because Versions does 
support them.

• PVCS uses revision names such as “1.1”, while Versions uses version numbers
as 1, 2, and 3. The revision numbers of the PVCS main trunk are mapped to Ver
version numbers.

Importing Projects from PVCS

You can import projects (one at a time) from PVCS 5.2 to Versions. Be sure to check 
changed working files prior to performing the import so that no work is lost.

To import projects from PVCS:

1. Select PVCS Import to run pvcsimp.exe. (In Windows 95, PVCS Import is on the
submenu for Versions. It is an icon in the Versions program group in NT.)

If PVCS Import finds a PVCS installation, the Versions PVCS Import dialog open

2. Select a project to import from the Projects list box.

3. To see details about the PVCS project, click Project Detail.
The Log Output box displays information about the selected project, such as its n
configuration file, project descriptor root, archive directory, working directory, fold
names, and filenames.
14-2 Versions User’s Guide
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4. Click Import... to specify the information Versions needs to create a project.
The Project Import Parameters dialog opens.

5. Type a name for this project in the Project Name text box (or use its PVCS nam
which is the default).

6. Type the pathname for a working directory for the project.

Or,

Click Browse... to locate one.

7. Type the pathname for the file that will store the Versions project database file (.

The directory that stores the project database file will also store the project vault
equivalent of PVCS’s archive directory.

The revisions (or versions) of files from the imported project will go into the proje
vault. Versions uses the name of the project database file (but this time with the
extension .vlt) as the name of the vault directory. Let Versions control these files
not delete them or modify them in any way.

8. Type the name of a person who will be an administrator for the project in the Fir
User text box.

An administrator can set project properties, assign users, etc. Authors of files in
project also become administrators as part of the import process.

9. Select Import All Revisions (main trunk) or the Import Latest Revision Only optio
button to indicate how many versions of each file to import.

10. Select the Compress check box to compress the vault files of the imported file o
leave it cleared to avoid compression.

11. Use the default log file name to record the actions performed during the import p
cess.

Or,

Type the pathname for a log file.

Or,

Click Browse... to locate one.
Importing Projects from PVCS 14-3
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12. Click Import.

A progress dialog displays a progress meter. A Cancel button in the progress dia
allows you to cancel the import.

13. After the import, the Versions PVCS Import dialog reappears.
Repeat steps 2 through 11 to import another project or click Done.

Inspecting the Imported Files

After you import a project from PVCS 5.2 to Versions, you will want to look at the resu

To inspect the imported files:

1. Run Versions.

2. Click Open Project  and locate the .stp file for the imported project.

The project window opens.

3. Click All Descendants  to see the contents of all the subprojects.

You see the name of each file, its author, description, subproject, path, etc.

4. Use Versions Help for more details.

Checking Out the Imported Files

After you import a project from PVCS 5.2 to Versions, it is a good idea to check out a
the files you will be using. 
14-4 Versions User’s Guide
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To check out all the imported files:

1. Run Versions.

2. Click Open Project  and locate the .stp file for the imported project.

The project window opens.

3. Click All Descendants  to see the contents of all the subprojects.

You see the name of each file, its author, description, subproject, path, etc.

4. Select Files Ö Select All... from the menu bar.

5. Select Files Ö Check Out... from the menu bar. Select the Force Check Out chec
box, and click OK.

Specifying Project Properties

After you import a project from PVCS 5.2 to Versions, you will want to set properties
it in Versions.

To set project properties:

1. Run Versions.

2. Open the imported project.

3. Select Project Ö Properties... from the menu bar.

The Project Properties dialog opens.

4. Use Versions Help for more details.
Importing Projects from PVCS 14-5
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Appendix A
Glossary

add files The process of placing files under version control by addin
them to a Versions project.

administrator A functional role in the operation of Versions. To become a
project administrator, you must create the project, import 
the project, or have another administrator change your use
properties to designate you as an administrator.

When project security is enabled, only project administra-
tors can create or branch subprojects, change project prop
ties, break locks, manage team member information, modif
the number of versions for a file, designate or delete perm
nent versions, purge non-permanent versions, designate 
builds and milestones, and perform delete operations.

alphanumeric A value consisting of the letters A-Z, and the digits 0-9.

archive For PVCS users, a synonym for vault. See vault.

Others often use it to mean a backup copy of a program o
data file saved to ensure against loss in case the original 
materials are deleted or damaged. Archived files can be 
stored on tape, floppy disks, or another computer system.

audit entry A record of an action performed on a Versions project that
appears in the audit log. For example, every time a file is 
added to a project, that action is entered in the audit log.
Glossary A-1
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audit log A chronological record kept by Versions showing all 
actions performed on Versions projects, subprojects, files,
and users.

author Information stored by Versions about files and versions. 

For a file: The user who added the file to the project.

For a version: The user who checked in the version.

automatic refresh An automatic update feature of Versions. Since projects, 
subprojects, and files managed by Versions are subject to
continuous revision by various team members, screen info
mation can become outdated after it is first displayed. The
Automatic Refresh function periodically reads the project 
database to update the displayed information.

binary file Any file that is not strictly an ASCII text file. Binary files 
contain programs or data in machine code. Examples of 
binary files and their respective file name extensions are 
executables (.exe), resources (.res), word processing docu
ments (.doc in Word for Windows), spreadsheets (.xls in 
Excel), object files (.obj) and bitmaps (.bmp).

branch The process of creating a second, independent subproject
from the contents of an existing subproject. The branch ma
become a project in its own right or later be merged back 
into the subproject from which it originated. For example, 
the development of a product for a new operating system 
may start with the existing files for the first operating sys-
tem as its base.

Also a branch of a tree, such as the project tree or a topic 
tree.
A-2 Versions User’s Guide
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build The process of compiling, assembling, and linking all 
project files in proper sequence to produce the project´s 
product. Versions uses the build command provided as a 
project or subproject property to create the build.

Also an event in the life cycle of a product chosen to repre
sent a quantifiable step in progress for a project. For exam
ple, a software product may deliver a new build every few 
days to the team members who test the product. Designati
a build creates a set of non-permanent versions at the 
project level. Each version of a file in the build uses the 
name of the build as its label. When project security is 
enabled, only an administrator can designate a build. A 
build cannot be designated at the subproject level.

build command A command that you specify so that Versions can, with a 
single operation, compile, assemble, and link all project 
files in proper sequence to produce the project or sub-
project's product.

build label The name or number given to a specific build. When you 
designate a build, Versions assigns the build label to the 
specified version of each file in the project.

check-in The operation performed on a file that has undergone revi
sion that stores the new file version in the Versions projec
vault. 

Versions permits a number of individuals to work on a com
mon set of files by allowing only one team member to 
revise a project file at a time. Check-in marks the end of on
revision. The team member who checks in the file can kee
it locked or release the file to others by unlocking it.

check-out The operation that copies a version of a file from the Ver-
sions project vault to a team member´s working directory. A
team member can check out a file with or without the inten
tion to alter that file. Versions permits a number of individu
als to work on a common set of files by allowing only one 
team member to revise a project file at a time. Locking the
file marks the beginning of one author's revision.
Glossary A-3
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column header The label or name for a column in lists that appear in the 
right pane of the Versions project window. Clicking the 
header initiates sort operations based on the values in tha
column. 

To hide a column, locate the bar that follows the column 
header (and separates that header from the one that follow
it). Drag the bar to the left edge of the column. When you 
release the mouse button, you should no longer see the 
header.

command-line file When you compare two files or versions, Versions sends a
command-line file to Visual Diff containing the appropriate 
parameters. If there is no space for this file or no temp dire
tory to create it in, an error message appears.

context menu (or 
pop-up menu)

A menu that appears when you right-click an item in the 
project window. The menu contents vary with the context, 
i.e. what has been clicked. In general, a context menu con
tains the most commonly used items from a related pull-
down menu on the menu bar. In some cases, the items on
the context menu are shortcuts. For example, if you select
Check In from the context menu that appears in the files lis
you bypass the Check In dialog.

defect A fault, error, or suggestion for a product. If you use Ver-
sions along with StarTeam Workstation 2.0, you can check
in files and fix defects at the same time.
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e 

n 

 
o 

-

 
-

 

-

.

delete To remove information from Versions databases. You can
delete:

• Projects. Deleting a project deletes the project databas
file (.stp) and the vault for that project.

• Project files and working files.

• Versions of a file. To delete a file version, the file must 
be locked. 

• Audit entries. You can clear the entire log or delete 
everything up to a specified date.

• Working files as part of removing a subproject or file 
from version control.

When project security is enabled, only an administrator ca
perform these operations.

See also remove from version control.

delta storage A method of computing differences between progressive 
versions of a file.

Versions implements reverse deltas for text files, which 
means that only the latest version of the file is saved in its
entirety. Delta storage reduces the disk space necessary t
store the version information of a file by comparing new 
and previous versions of the file and storing only the differ
ences.

e-mail An organized system for delivery of paperless, “electronic”
messages, named for its similarities to the postal mail sys
tem. Versions provides advantages (such as mailing files 
and reports) for teams that use a MAPI-compliant e-mail 
system. 

file compression A technique for reducing the size of a file by removing 
redundant information from it. Most disk files contain repe-
titions of common sequences of characters. Compression
algorithms remove the additional occurrences of these 
sequences and save information that permits their restora
tion. By selecting compression of files, you may reduce 
vault space requirements as well as improve performance
Glossary A-5
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files list The list of files for the subproject, selected from the projec
tree, that is displayed when you select the Files tab. The lis
is further refined by the scope button and filter you select.

filter The criteria used to select a few items from among many. 
The Filter drop-down list box in the project window allows 
you to display only the files or audit entries that are of inter
est.

filtering The technique of selecting a few items from among many 
by specifying criteria that eliminate unwanted items. For 
example, you can select only files submitted within the las
month.

group band The label that separates data with the same value in a give
column from the data above it in the list. Depending on the
column, group bands may appear in the project window 
after you click a column header to sort the data based on th
value in that column. For example, sorting by the Author or
User column breaks down the information by team membe
and displays group bands to make viewing and report gene
ation easier.

history list The list of versions for the file selected from the project tree
that is displayed when you select the History tab from the 
bottom of the project window’s right pane or from the File 
Properties dialog.

keyword Reserved words beginning and ending with a dollar sign ($)
When used in a text file, Versions replaces them with the 
data that they represent. For example $Author$ is replace
by the name of the user who checked in the file.

keyword expan-
sion

A technique used to insert information in a text file in which
keywords are replaced by the data they represent. For exa
ple $Author$ is replaced by the name of the user who 
checked in the file.
A-6 Versions User’s Guide



, 

 
 

r 
r-

e 
ra-

d 

 

 a 
r 
lock The process by which you indicate to others that you are 
revising a file. Others can check out a file you have locked
but they cannot check it in unless they break your lock. 
When security is enabled, only administrators can break 
locks.

Optionally, team members can have unlocked files marked
read-only, which prevents them from making any changes
to files that may be locked by others. 

A file must be locked before you can check it in, delete it o
one of its versions, change its number of maximum non-pe
manent versions, purge its non-permanent versions, or 
change a version from non-permanent to permanent or vic
versa. When security is enabled, you must be an administ
tor (and lock the file) to perform any of the above except 
check-in.

locker The team member who has locked a file is known as its 
locker.

MAPI Acronym from (Mail Application Programming Interface). 
A programming interface that permits an application to sen
and receive electronic mail via the Microsoft Mail messag-
ing system.

merge The process of combining a working file with the latest 
checked-in version of that file or of combining a branched 
file with the root file from which it was branched. In either 
case, the combined file is placed in the user´s working 
directory where it can be inspected or revised before being
checked in.

milestone An event in the life cycle of a product chosen to represent
significant step in progress, for example, the alpha, beta, o
final release of a product. In Versions, a milestone desig-
nates a single set of permanent versions for the files in a 
project. 
Glossary A-7
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Each version in the milestone has the same label. When 
project security is enabled, only an administrator can desig
nate a milestone. Milestones cannot be designated at the 
subproject level.

NetBIOS over 
NetBEUI

A common network protocol for PC LANs that provides 
session and transfer services. NetBEUI is an acronym for 
NetBIOS Extended User Interface and provides a standard
ized transport frame for NetBIOS.

non-permanent 
(also temporary or 
interim)

A designation applied to any version of a file included in a 
Versions project that has not been defined as permanent. 
The oldest non-permanent version is automatically deleted
when the maximum number of versions is exceeded.

To purge a file of its non-permanent versions, change the 
status of a file version from non-permanent to permanent, o
change the maximum number of non-permanent versions t
be stored, the file must be locked. When project security is
enabled, only an administrator can perform these opera-
tions.

numeric A value consisting of the valid digits 0-9.

omega storage A method of file version storage in which all versions of a 
file are saved in their entirety. Omega storage eliminates th
long processing times necessary to reconstruct complex 
binary files stored in delta or reverse delta format and can 
actually consume less disk space than other storage metho
used on binary files.

Versions stores all binary files in omega format. You can 
also store text files in omega format. This is a time and ofte
a space-saving decision for large, rapidly changing text file
such as Windows help files (.rtf).

owner A Versions-maintained attribute of an audit entry. An audit
entry’s owner is the subproject or file receiving the action. 
Note that an owner is NOT an individual.
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permanent A designation applied to a specific version of a file included
in a Versions project. Making a version permanent preven
Versions from deleting it from the project vault when the 
maximum number of non-permanent versions has been 
reached or when the file is purged. Permanent file version
can only be deleted using HistoryÖDelete.

To change a version’s status from permanent to non-perm
nent (or vice versa), the file containing that version must b
locked. When project security is enabled, only an adminis-
trator can perform these actions.

project A set of related files comprising a single product under Ve
sions version control.

project database 
file

Also referred to as the project file. The database file, desig-
nated during the creation of a project, that stores project 
information. By default, it ends with an .stp extension. See
also (but do not confuse with) project file.

project file A file under version control; therefore, a file that is in a Ver
sions project. See also (but do not confuse with) project 
database file.

project tree The hierarchical display of a Versions project and its assoc
ated subprojects and files. The project tree is always dis-
played in the left pane of the project window.

project window The window in which an open project is displayed by Ver-
sions. It contains two panes. The left pane displays the 
project tree and the right pane displays the files, versions, 
audit log entry trees associated with the subproject or file 
selected from the project tree.

purge The deletion of non-permanent versions from a file. If only
one version of a file remains, that version cannot be purge
The most recently checked-in version is also never purged

To purge a file, the file must be locked. When project secu
rity is enabled, only an administrator can purge a file.
Glossary A-9



 

 

 
 

remove from ver-
sion control

To delete all information about a file or subproject from the
project database file (.stp) and the vault. To remove a file, 
the file must be locked. When project security is enabled, 
only an administrator can perform either of these opera-
tions.

response Any of a number of replies to a topic, that along with the 
topic, form a hierarchical structure called a topic tree.

right-click The action of pressing and releasing the secondary mouse
button. Since most mice are configured for right-handed 
operation, the left button (under the index finger) is the pri-
mary button and the right button (under the middle or ring 
finger) is the secondary button.

root subproject The topmost folder in the project tree hierarchy.

scope buttons The buttons at the top of the right pane. Depending on the
contents of the right pane, one or all of the buttons may be
disabled.

  No Descendants

Displays information only for the item selected from the 
project tree.

 Immediate Descendants

Displays information for the selected item and its children 
(when the selected item is a subproject).

All Descendants

Displays information for the entire branch. This includes 
information about the selected item, its subprojects, and 
their files.
A-10 Versions User’s Guide
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secondary sort Sorting items by group in a list that is already sorted (pri-
mary sort). For example a file list might be sorted by exten
sion, then (in a secondary sort), sorted by name within 
groups of the same extension.

Click a column header to perform a primary sort; right-click
a second column to perform a secondary sort.

server A computer or system that provides services to clients. Th
clients may be other computers.

sort or primary 
sort

To place items in ascending or descending order in the rig
pane of the project window based on the value in the col-
umn whose label you click. Depending on the values in the
column, the values are sorted numerically or alphanumeri-
cally. Click once to sort. Click a second time to change the
sort order from ascending to descending or vice versa. 
Right-click to create a secondary sort.

subproject A set of related files comprising a discreet portion of a prod
uct under Versions version control.

team member Any of the project users. Sometimes used to denote a use
that does not have administrator status.

team list The list of team members for the project. Select the Team
tab to display the list and information about each team 
member.

test command A command that you specify so that Versions can perform
in proper sequence, an automated test procedure for a 
project or subproject's product.

text file or ASCII 
file

A file that contains only printable text characters, spaces, 
carriage returns, and sometimes tabs and an end-of-file 
marker, without any formatting codes.
Glossary A-11
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time stamp Information maintained by Versions about files, versions, 
and audit entries.

For file versions: The date and time that the file was 
checked into Versions.

For files: The date and time for the working file.

For audit entries: The date and time that the event occurre

unlock The process of releasing a locked file so that others can 
check it in.

user An individual identified to Versions and given access to one
or more projects and their component subprojects and files
When project security is enabled, that access is protected b
password. A user is also referred to as a team member.

vault A directory where versions of the files that are under ver-
sion control are stored. This directory´s name ends with a 
.vlt extension and is a subdirectory of the directory where 
the project database file (.stp) is stored.

vault file A file in the project vault that stores versions of a project 
file.

version or revision A copy of a file stored in the project vault. One or more of 
these versions may exist.

version attributes Data stored for each version of a file under version control
including version number, time stamp, author, file size, per
manent or non-permanent status, version labels (if any), an
reason for check-in.

version control Version control is the process of storing and tracking the 
various changes (versions or revisions) to one or more files
A version control system maintains the version history gen
erated as the files evolve into their final forms.
A-12 Versions User’s Guide
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The main advantage of using an automated version contro
system is fast, easy recall of previous versions. If you are o
a network, Versions also provides a quick, easy-to-use 
method of obtaining versions of files being generated and 
maintained by other users working on a project with you.

version control 
system

Application software to help manage multiple versions of 
the same file.

version label A version label provides a convenient method of identifying
a version of a file by name. This is valuable when you are 
checking in a group of files that may need to be checked o
together. When multiple files are involved, each file will 
generally have a different number of versions. By selecting
a version label, you can check out all files related to a spe
cific change by referencing that version label. Every versio
within a build or milestone has the same version label.

version number The version number is an identification number assigned b
Versions when a version is checked in. You can use this 
number to access the version. Versions uses it to determin
if you need to check out versions of the files currently 
stored in your working directory.

Visual Diff A companion program to Versions. Visual Diff compares 
two text files or two versions of one text file and shows the
differences (if any) between them.

working directory The directory designated to hold the working copies of files
that have been checked out of the Versions project vault. 
is also the directory from which files are added to or 
checked in to a subproject.

working file A copy of a file under version control which has been 
checked out of the vault so it can be reviewed or edited. 
Versions copies working files to the designated working 
directory on a workstation. This is in contrast to the stored
file versions that are located in the vault.
Glossary A-13
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workstation data-
base file

The file stwork20a.db is the workstation database. It can b
stored in the directory where Version 2.0 is installed, but it
is usually in the Windows directory. The database contains
information about what versions of files are in your working
directories and so forth. For example, Versions uses it to 
determine what needs to be checked in or out. 

workstation 
options

User-selectable choices for the behavior of Versions on a 
specific workstation.
A-14 Versions User’s Guide
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Appendix B
Your Computer Clock
Versions does not rely exclusively on your computer’s clock and the date and time s
of your working files to determine what needs to be checked in or checked out. Vers
will still function properly, even if your computer’s clock is not in sync with other team
member’s clocks. 

However, most compilers and development environments are still sensitive to the dat
time stamps. Files that were checked in by another member of your team will, by de
have the date and time stamp set by your teammate’s clock, even when you check t
out. If your clock is not in sync with your teammate’s, you may experience problems c
piling or building the file. Therefore, we still recommend using whatever service your
work server supports for synchronizing all workstation clocks.

For Windows networks, use:

net time \\server_name /set /yes
Your Computer Clock B-1
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Appendix C
Using Versions 2.0a and 
StarTeam Together
Since Versions and StarTeam 2.1 both use the same format and file extensions (.stp
.vlt), you can share and view files between applications. In fact, Versions and StarTe
2.1 can access the same projects simultaneously. However, StarTeam offers additio
functionality. It allows you to add or edit defects that you can only view in Versions. 
StarTeam Workstation 2.1 also allows you to add threaded conversations to projects
subprojects, and files. 

Opening a Project

When you open a project with Versions, you must know the name of its project data
file (.stp) and have read/write access to the location where it is stored. This gives yo
server access (also called local access) to the project. With file server access, data 
processed on your workstation.

When you open a project with StarTeam Workstation Professional 2.1, you can open
file server access or for client/server access. With client/server access (also called r
access), data is processed on the server and only the results are sent to your works
Client/server access is possible only when StarTeam Workstation Professional is us
with its optional companion product, StarTeam Server. (StarTeam Workstation only 
provides file server access.)
Using Versions and StarTeam Together C-1
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The following procedure assumes that you are using file server access for both Vers
and StarTeam Workstation 2.1.

To open a project:

1. Open either Versions or StarTeam Workstation 2.1.

2. Select Project ÖOpen... from the menu bar.

The Open Project dialog opens.

3. Use the Look In drop-down list box (and the list box beneath it) to select the drive
directory where the project is located.

4. Double-click the project database file (.stp) to be opened.

The Log On dialog opens.

5. Type your password if one is required.

A project window displays the project and its subprojects.

Viewing Defects in Versions

The Defects tab contains defects associated with the selection from the project tree.
Although Versions does not have full defect tracking capabilities like StarTeam 
Workstation, limited access is provided.

Two icons might precede each defect. One indicates its status; the other appears onl
defect is a priority.
C-2 Versions User’s Guide
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To view defects created in StarTeam Workstation associated with a subproject:

1. Click the subproject, then select Project Ö Properties... from the menu bar.

Or,

Right-click the subproject, then click Properties... on the context menu.

The Project Properties or Subproject Properties dialog opens.

2. Select the Defects tab.

The Defects are displayed in the list box.

Use the right and left scroll arrows to view all the columns in the defects list:

Defect # Number that StarTeam Workstation assigned to the defect when 
was first submitted.

Status Indication of the defect’s progress from open to resolved to verifie
to closed. This is referred to as a defect’s life cycle.

Priority Indication that the defect is a:

 Priority

Not a Priority
Using Versions and StarTeam Together C-3



Severity Seriousness of defect:

Severity High (red light)

Severity Medium (yellow light)

Severity Low (green light)

Responsibility Person who is responsible for the defect.

Synopsis Short explanation of the defect.

Date Entered The date the defect was submitted.

Build Tested Build in which the defect occurs.

Build Addressed Build in which the defect is resolved.

Author Person who submitted the defect.

Type Type of defect:

 Defect

 Suggestion

Owner Subproject or file to which the defect is attached.
C-4 Versions User’s Guide



rs a 
wing 

on 

ite  

t, 
ry. 
                              
         
Appendix D
Upgrading to StarTeam 2.1
Versions can be easily upgraded to the StarTeam 2.1 product family which offers 
additional functionality such as:

• Client/server architecture (StarTeam Workstation Professional)

• Defect tracking

• Threaded conversations

• Internet, WAN, and dial-up connectivity. 

Versions lets you get started with an effective version control solution. StarTeam offe
more advanced and robust software configuration management solution for your gro
projects. All of your Versions projects can be accessed in StarTeam Workstation.

StarTeam 2.1 includes StarTeam Workstation Professional 2.1, StarTeam Workstati
2.1, StarTeam Server 2.1, and StarTeam Web Connect 2.1.

StarTeam Workstation StarTeam Workstation Professional is a tightly integrated su
Professional of SCMtools including version control, visual differencing, 
              defect tracking, threaded conversations, build managemen
           audit logs, status reports, and an advanced project reposito
              StarTeam Workstation Professional can be used for file server

access or for client/server access and focuses on the larger 
team issues that affect delivery of applications.
Upgrading to StarTeam D-1
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StarTeam Workstation StarTeam Workstation offers the same functionality as     
StarTeam Workstation Professional with the exception of 
remote access. StarTeam Workstation is ideal for small grou
using local area networks.

StarTeam Server StarTeam Server provides support for distributed StarTeam
Workstation development teams and mobile team members
providing access to projects through Internet, intranet, WAN
or dial-up connectivity. This removes any limitations on whe
development team members or consultants are located. In 
addition, StarTeam Server uses client/server technology to 
increase performance and reduce network traffic. It provide
scaleable, secure solution that serves the needs of even the
largest development team.

StarTeam Web Connect StarTeam Web Connect provides access to application and
web site projects via a web browser. This revolutionary way 
working with and managing projects allows a wide range of
users to participate in an easy, secure, and cost effective 
development process. StarTeam Web Connect allows differ
views of the same project and dynamically gives each user 
appropriate project view based on the rights assigned to tha
user by the administrator.

As part of an application development project, StarTeam W
Connect provides a way for beta users, testers, consultants,
others to interact, provide feedback, and review information

As part of a web site project, it allows the webmaster to crea
a framework that meets the needs of everyone involved wit
content, graphics, testing, and responding to user input. In 
addition, StarTeam Web Connect is ideal for controlling we
site configuration and can operate standalone or in conjunct
with a commercial HTTP server.
Versions User’s Guide
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Who needs StarTeam 2.1?

StarTeam 2.1 offers an Integrated Team Environment (ITE) by using one interface fo
resources. StarTeam 2.1 runs on Windows 95 and Windows NT, and supports all po
file-based programming environments including C++, Visual Basic, Delphi, JAVA, an
Perl. Developers work more productively as a team because they have quick access
project information and each other across the LAN. With the optional StarTeam Serv
2.1 and StarTeam Web Connect 2.1, developers and others can also access projec
Internet, intranet, WAN, remote dial-up, and web browser. StarTeam 2.1 is recomme
for:

• Projects requiring integrated version control, defect tracking, and threaded conv
tion

• Web Site management

• Managers and developers needing to know project status

• Local and distributed development teams

• Interdepartmental teams including beta users, testers, writers, and consultants

• Projects requiring strong security
Upgrading to StarTeam D-3
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Feature Comparison

To order StarTeam Workstation Professional 2.1, StarTeam Workstation 2.1, StarTe
Server 2.1, and/or StarTeam Web Connect 2.1, please contact StarBase Corporatio
888-STAR-700 between 9 A.M. and 5 P.M. Pacific time, Monday through Friday.

Feature Versions StarTeam 2.1

SCM Functionality Version control

Visual differencing

Build management

Audit logs

Project repository

File, version history, 
team, and audit log 
charts & reports

Version control

Visual differencing

Build management

Audit logs

Project repository

File, version history, 
team, audit log, charts 
& reports

Defect Tracking

Threaded Conversa-
tions

Scalability FAT Client/LAN FAT Client/LAN

WAN/Internet

Communication N/A Internet

Dialup

WAN

Web Browser Access N/A Yes

Web Site Management N/A Yes

Security Limited Advanced
D-4 Versions User’s Guide
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Appendix E
StarBase Technical Support
If you have a question about Versions, you can:

1. Consult the online help and written documentation.

2. See the README.WRI file that comes with Versions.

3. Post a message to our CompuServe forum. 

GO STARBASE

Then visit the StarTeam message and library sections.

4. Send a message to support@starbasecorp.com.

5. Access our web site at:

HTTP://www.starbasecorp.com

Check for new support questions and answers.

If you can't find the answer from any of these sources, or if you require information a
product registration or replacement disks, call StarBase Technical Support Services
(714) 442-4460 between 9 A.M. and 5 P.M. Pacific time, Monday through Friday.
Technical Support E-1
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When you call StarBase Corporation Technical Support Services, please have the 
following:

• The version number of the Versions software you are using.
(From Versions, select Help Ö About Versions....)

• The exact error message you received, if any.

• A precise explanation of what you were doing when the error occurred.

• The version of Windows you are using.
(Select Start Ö Settings Ö Control Panel. Then select the System icon. The versio
appears on the General property page.)

• The type of hardware you are using.

• The network operating system you are using, if any.

StarBase support services are subject to StarBase prices, terms, and conditions in p
the time the service is used.

For information about product upgrades and pricing, call StarBase Corporation at 
1-888-STAR700 or (714) 442-4500 between 9 A.M. and 5 P.M. Pacific time.
E-2 Versions User’s Guide
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Appendix F
Questions and Answers
This appendix answers commonly asked questions about Versions.

Q: How can I improve Versions’ performance?

A: Do some of the following:

• Organize your subprojects for efficient access. It is best to make the project 
archy as flat as possible. Wherever you can, make subprojects siblings rath
than parent and child. 

• Pack the project database file (.stp) using the Project Maintenance utility.

• Use vault file compression. 

(Select Project Ö Properties…, then the Default tab. Select the Use Compres
sion check box.)

• Disable the audit log. 

(Select Project Ö Properties…, then the Name tab. Clear the Audit Log check
box.)

Q: How does Versions know what files are ready to check in or out?

A: Versions uses a workstation database (stwork20a.db) and the time stamp on file
determine what you should check in or out.
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Q: What if the workstation database file (stwork20a.db) is corrupted or lost?

A: If you lose the workstation database file (stwork20a.db), Versions recreates it 
automatically. To resynchronize your workstation information, check out your pro
files again. 

Q: Do I need to do backups?

A: Versions project vaults are not a replacement for backups. In fact, it is critical that
back up the following:

• Project database files (.stp)

• Their vault directories (.vlt)

• The files within the .vlt directories

In certain environments, open files are not backed up. Because a wide audience
access a Versions database project file at various times of day, a project may al
be open by at least one user. 

To make sure that project database files (.stp) are backed up even if they are op
copy them and their associated vault directories (.vlt) and files to another server
location and have that location backed up instead. Perform this copying process
before the backup process or automate it using the operating system’s schedulin
service.

Q: How is your project information stored? Is it stored in a known database format o
you store it in a proprietary format?

A: We are using the Access database format to store much of the data. Actual file 
versions are stored in StarBase’s own proprietary format.

Q: Is your Versions product integrated with the Visual Basic, Visual C++, or Delphi 
environments?

A: Versions supports any file-based development environment. You can launch you
development environment from within Versions as from File Manager or Windows
Explorer. 
F-2 Versions User’s Guide



 

 files 

ed 
oject 
ject as 
jects. 

our 
ne of 

lem?

 
iles” 

 to 
e 
 log 

g 

age: 
 do 

n or 
s in 
For other IDEs, such as Microsoft’s Developer’s Studio, Versions’ command-line
utility allows you to perform version control functions if the development 
environment allows you to add tools to menus.

Q: How does your product deal with shared files? Most of our projects have a set of
in common.

A: Since Versions permits you to have more than one project, you can put the shar
files in a single project (named, for example, Shared Files). When you open a pr
that uses the files in the Shared Files project, you can open the Shared Files pro
well. You perform actions, such as check-ins and check-outs, in two separate pro

The alternative is to include all your “projects” in one Versions project. Each of y
projects becomes a subproject of the one large project. Shared Files would be o
those subprojects.

Q: I am currently unable to check in changes I have made to a file. What is the prob

A: You need to lock the file. A number of different operations require that the file be
locked. For a complete list of these operations, see the “Locking and Unlocking F
section in Chapter 4.

Q: Can I bypass the Log On dialog when security is disabled?

A: You cannot bypass the Log On dialog. Versions needs to know your user name
note author information and monitor locker data. The logon name you use for on
session becomes the default logon name for the next session. This allows you to
on to a project that does not enforce security quickly by pressing Enter or clickin
OK. 

Q: When I try to check in changes that I have made to one of my files I get this mess
“File in use by another, try again later.” I know no one else is using the file. Why
I get this error message. What can I do so that I can check this file in?

A: This error message occurs as a result of an abnormal interruption in the check-i
check-out process. As a part of these processes, Versions creates temporary file
the project vault directory (.vlt directory). 
Questions and Answers F-3
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When the process completes successfully, Versions automatically deletes these
When the process is interrupted, these files need to be deleted manually. 

Use the File Manager or Windows 95 Explorer to look for files in the project vaul
directory with unusual names. Vault files usually have names like vv1.vvf or 
vv10.vvf. 

The abnormal file names are similar to __cvn___. or have an underscore (_) in th
position of the file extension. They are generally 0 bytes in length. Delete these 
temporary files. Sometimes you have to exit Versions and restart Windows befor
error is resolved. Be extremely careful not to delete any files with the .vvf extens
F-4 Versions User’s Guide
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Symbols
$differences. See comparing 12-1
.bat files 10-2
.cmd files 10-2
.stp file 2-6
/c parameter 13-7
/d parameter 13-4, 13-13
/dc parameter 13-7
/f parameter 13-6, 13-9
/fo parameter 13-6
/is parameter 13-3
/k parameter 13-4, 13-6, 13-18
/l parameter 13-4, 13-6, 13-8, 13-15
/md parameter 13-5, 13-16
/mo parameter 13-5, 13-16
/nl parameter 13-10, 13-11
/o parameter 13-6, 13-9, 13-14
/p parameter 13-2
/pw parameter 13-3
/q parameter 13-3
/r parameter 13-6
/ro parameter 13-4, 13-6, 13-8, 13-15
/s parameter 13-3
/ts parameter 13-9
/u parameter 13-4, 13-6, 13-8, 13-15
/un parameter 13-3
/vd parameter 13-9, 13-10, 13-12, 13-

18
/vl parameter 13-4, 13-6, 13-9, 13-12,

13-14, 13-18

/vn parameter 13-9, 13-14, 13-18
/x parameter 13-3
A
add

command-line option 13-4
adding

files 4-7, 4-14
group to team 5-4
user to team 5-3
users to groups 5-6

adding files
at command-line 13-4
defined A-1

Admin
team list 5-2

administrators
defined A-1

advantages
projects 2-1

alphanumeric
defined A-1

archive
defined A-1

ASCII files
comparing 12-1
defined A-11
delta storage 4-1
omega storage 4-1

attaching
versions to e-mail 7-4

audit entries
defined A-1
See entries
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audit log
charts available 9-4
clearing 6-7
columns 6-2
controlling 6-1
Date Range 6-4
defined A-2
Description 6-3
disabling 6-6
displaying 6-1
double-clicking 6-3
emptying 6-7
enabling 6-6
Error 6-2
Event 6-2
events 6-5
filters 6-4
group bands 6-3
Information 6-2
menus 6-3
Only File Events 6-4
Only Project Events 6-4
Only Subproject Events 6-4
Only User Events 6-4
Owner 6-3
reports available 8-4
sending entries 7-5
Show All 6-4
sorting 6-3
Time Stamp 6-2
Type 6-2, 6-4
User 6-2
User=Me 6-4
Warning 6-2

Audit Trail tabs 6-2
Author

column in defects list C-4
column in files list 4-5
history list 4-12

authors
defined A-2

automatic
messaging 7-1
refresh 10-3
scope change 10-2

automatic refresh
defined A-2

B
backing up

projects F-2
backups F-2
bars, splitter 12-2
bat files 10-2
benefits 1-1
binary files

defined A-2
omega storage 4-1

bitmaps, copying charts as 9-4
black

matching text color 12-4
blue

changed text color 12-4
branching

defined A-2
merging subproject after 3-19
subprojects 3-17

bugs. See defects
Build Addressed

column in defects list C-4
build commands

defined A-3
build labels

defined A-3
Build Tested

column in defects list C-4
builds

checking out 4-29
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commands 2-13, 2-19, 3-5, 3-6,
3-14, 3-15

defined A-3
designating

at command-line 13-10
labels 4-2

at command-line 13-10, 13-11
buttons

chart toolbar 9-4
scope

at time of change 10-2
C
changing 10-2

chart colors 9-5, 9-8
chart data 9-7
chart fonts 9-6, 9-10
chart legends 9-9
chart patterns 9-8
chart titles 9-6, 9-10
chart types 9-5, 9-6
file descriptions

at command-line 13-12
group’s membership list 5-6
passwords 5-8
scope 10-2
user’s e-mail name 7-3
Visual Diff colors 12-4

charts
adding depth 9-5
available 9-3, 9-4
changing colors 9-5, 9-8
changing data 9-7
changing patterns 9-8
changing types 9-5, 9-6
copying as bitmaps 9-4
copying as data 9-5
creating 9-1
defining data for 9-1
editing legend text 9-9

editing title text 9-6, 9-10
exploding pie 9-11
exporting 9-4
fonts 9-6, 9-10
grids 9-5
importing 9-4
legends 9-5
options 9-6
pallet bar 9-8
pattern bar 9-8
printing 9-5
removing patterns 9-8
rotating 9-5, 9-11
saving 9-4
swiveling 9-11
team 9-3
tilting 9-11
toolbar 9-4
tools 9-6
two/three dimensional 9-5, 9-10
window 9-4
z-cluster 9-5
zooming 9-5

check-in
defined A-3
labels for versions 4-2
resolving defects 4-3

checking
project database files 11-3

checking in
duplicate versions

at command-line 13-6
files 4-6, 4-19, 13-6, F-1, F-3

at command-line 13-5
options 4-7
overriding defaults 4-8
reasons 13-6
retaining locks on files 10-2
setting defaults 4-17
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versions 1-5, 4-8
working files deleted 10-2

checking out
builds 4-29
files 4-6, 4-22, 4-24, 13-9, F-1

as locked 10-2
at command-line 13-8
with read-only status 10-2

forced
at command-line 13-9

milestones 4-29
options 4-7
overriding defaults 4-8
setting defaults 4-17
versions 4-7

check-out
defined A-3

ci
command-line option 13-5

clearing
audit log 6-7

cmd files 10-2
cmp

command-line option 13-7
co

command-line option 13-8
codes

changing colors 12-4
colors in Visual Diff 12-4

collapsing
project trees 2-3

colors
changing chart fonts 9-6, 9-10
changing charts 9-8
changing Visual Diff 12-4
charts 9-5
default 12-5
Visual Diff 12-4

column headers
defined A-4

column in team list
Admin 5-2
User Type 5-2

columns
audit log 6-2
files list 4-4
history list 4-12
sorting data 2-5
team list 5-2

command-line 13-3
/c parameter 13-7
/d parameter 13-4, 13-13
/dc parameter 13-7
/f parameter 13-6, 13-9
/fo parameter 13-6
/is parameter 13-3
/k parameter 13-4, 13-6, 13-18
/l parameter 13-4, 13-6, 13-8, 13-

15
/md parameter 13-5, 13-16
/mo parameter 13-5, 13-16
/nl parameter 13-10, 13-11
/o parameter 13-6, 13-9, 13-14
/p parameter 13-2
/pw parameter 13-3
/q parameter 13-3
/r parameter 13-6
/ro parameter 13-4, 13-6, 13-8,

13-15
/s parameter 13-3
/ts parameter 13-9
/u parameter 13-4, 13-6, 13-8, 13-

15
/un parameter 13-3
/vd parameter 13-9, 13-10, 13-12,

13-18
/vl parameter 13-4, 13-6, 13-9,
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13-12, 13-14, 13-18
/vn parameter 13-9, 13-14, 13-18
/x parameter 13-3
adding files 13-4
allowing a duplicate check-in 13-6
build labels 13-10, 13-11
bypassing error messages 13-3
changing file descriptions 13-12
checking in files 13-5

that match filter 13-6
checking out files 13-8

that match filter 13-9
compressing files 13-7
decompressing files 13-7
deleting versions 13-13, 13-14
delta maximum 13-5
delta storage 13-16
designating builds 13-10
designating milestones 13-11
file descriptions 13-4, 13-13
files parameter 13-3
forcing a check-out

at command-line 13-9
forcing omega storage 13-5
including subdirectories 13-3
locking files 13-4, 13-6, 13-8, 13-

14, 13-15
maximum number of versions 13-16
maximum numbers of versions 13-

15
merging files 13-16
milestone labels 13-10, 13-11
omega maximum 13-5
omega storage 13-6, 13-16
password parameter 13-3
permanent version 13-4, 13-6, 13-

18
permanent versions 13-18
project database file parameter 13-2

purging files 13-19
read-only files 13-4, 13-6, 13-8,

13-15
reasons for check-in 13-6
stcmd add 13-4
stcmd ci 13-5
stcmd cmp 13-7
stcmd co 13-8
stcmd dbd 13-10
stcmd dms 13-11
stcmd dsc 13-12
stcmd dvr 13-13
stcmd lck 13-14
stcmd mnv 13-15
stcmd mrg 13-16
stcmd prg 13-19
stcmd prm 13-18
subproject name 13-3
suppress progress reporting paramet

13-3
syntax 13-2
time stamp 13-9
unlocking files 13-4, 13-6, 13-8,

13-14, 13-15
user name parameter 13-3
version date/time 13-9, 13-10, 13-

12, 13-18
version labels 13-4, 13-6, 13-9,

13-12, 13-14, 13-18
version numbers 13-9, 13-14, 13-

18
command-line files

defined A-4
command-line interface 13-1
commands

build 2-13, 2-19, 3-5, 3-6, 3-14,
3-15

project test 2-19, 3-15
test 2-13, 3-5, 3-6, 3-14
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comparing
files 4-30, 12-1
versions 4-30, 12-1

comparison
color code 12-4

compressing
files 2-24, 4-1, 4-34

at command-line 13-7
vault files 2-13, 2-23

confirming
deletions 10-1

context menus 2-3, 5-2
defined A-4

copying
chart bitmaps 9-4
chart data 9-5
subprojects 3-17

creating
build commands 2-13, 3-5, 3-6, 3-

14
charts 9-1
directory structure 4-14
directory structures 3-2
projects 2-10
reports 8-1
subprojects 3-4
test 2-13, 3-5, 3-6
test commands 3-14
versions 1-5

D
data

changing charts 9-7
copying charts 9-5
defining for charts 9-1
defining for reports 8-1
stored in project database (.stp) file 2-

6
database

formats F-2

workstation file F-2
database file 2-6
database files

packing 11-2
repairing 11-1
validating 11-3

Date Entered
column in defects list C-4

Date Range
audit log 6-4

date/time
versions 13-9, 13-10, 13-12, 13-

18
dbd

command-line option 13-10
decompressing

files 4-34, 13-7
defaults

colors in Visual Diff 12-5
project 2-13
projects 2-22
setting 4-17
version control 2-13

Defect #
column in defects list C-3

Defect icon
defects list C-4

defects
charts available 9-3
defined A-4
Owner C-4
resolving at check-in 4-3
viewing C-2

defects list
Author C-4
Build Addressed C-4
Build Tested C-4
Date Entered C-4
Defect # C-3
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Defect icon C-4
Priority C-3
Responsibility C-4
Severity C-4
Status C-3
Suggestion icon C-4
Synopsis C-4
Type C-4

defining
build commands 2-13, 3-5, 3-6, 3-

14
data for charts 9-1
data for reports 8-1
test commands 3-14

deleting
defined A-5
files 4-37
groups 5-9
projects 2-25
subprojects 2-25, 3-19
users 5-9
users from groups 5-6
versions 4-36

at command-line 13-13, 13-19
deletions

confirming 10-1
delta storage 4-1, 13-16

defined A-5
maximum numbers of versions

at command-line 13-5
depth

charts 9-5
of project trees 2-5

Description
column in audit log 6-3
column in files list 4-5

descriptions
files

at command-line 13-4, 13-13

designating
builds

at command-line 13-10
milestones

at command-line 13-11
dialogs

Check In 4-8
Check Out 4-8

differences 12-6
color codes 12-4

directories
creating 4-14
creating structures 3-2
working 2-6, 3-2

disabling
audit log 6-6
e-mail 7-2

display options
Visual Diff 12-8

displaying
audit log 6-1
chart legends 9-5
files list 4-3
history list 4-11
splash screen 10-3
status bar 10-3
team list 5-1
toolbar 10-3
warnings 10-1

dms
command-line option 13-11

DOS prompt
commands for StarTeam 13-1

double-clicking 2-3
audit log 6-3
history list 4-13
team list 5-2

drag-and-drop
project trees 2-3
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dsc
command-line option 13-12

duplicate versions
check-in

at command-line 13-6
dvr

command-line option 13-13
E
editing

chart legends 9-9
chart titles 9-6, 9-10
files 10-2
text 10-3

e-mail 5-3
defined A-5
disabling 7-2
enabling 7-2
MAPI-compliant 7-1
sending 7-3
sending reports 7-6
using 2-13, 2-23

e-mail messages
See messages

e-mail name
changing 7-3

emptying
audit log 6-7

enabling
audit log 6-6
e-mail 7-2

entries
sending 7-5

erasing
projects 2-25
subprojects 2-25, 3-19

Error icon
audit log 6-2

error messages
command-line 13-3

Event
column in audit log 6-2

events
audit log 6-5

excluding
files from root subproject 2-14
files from subprojects 3-6, 3-16

executing
build commands 2-19, 3-15
files 10-2
project test commands 2-19
subproject test commands 3-15

Exists
column in files list 4-5

expanding
keywords 2-13, 2-23, 4-26
project trees 2-3

exploding
pie charts 9-11

exporting
charts 9-4

Ext
column in files list 4-5

F
file compression

defined A-5
File Size

history list 4-12
files 13-15

.bat 10-2

.cmd 10-2
adding to project 4-7, 4-14
charts available 9-3
checking in 4-8, 4-19, 13-6, F-1,

F-3
checking out 4-7, 4-22, 4-24, 13-

9, F-1
comparing 4-30, 12-1
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compressing 2-24, 4-1, 4-34
at command-line 13-7

containing reports 8-5
decompressing 13-7
deleting 4-37
deleting versions

at command-line 13-14
descriptions

at command-line 13-4, 13-13
duplicate check-in

at command-line 13-6
editing 10-2
excluding from root subproject 2-14
excluding from subprojects 3-6, 3-

16
executing 10-2
finding matches 12-6
forced check out

at command-line 13-9
in project 4-6
keywords 4-26
locked

at check-out 10-2
locked by another 4-4
locked by you 4-4
locking 4-7, 4-18

at command-line 13-4, 13-6,
13-8, 13-15

managing 4-1
maximum number of versions

at command-line 13-15
merging compared 12-6
merging versions 4-8, 4-32
not in project 4-4, 4-6
omega storage

at command-line 13-5
order in project trees 2-3
order in Visual Diff 12-4
packing database files 11-2

printing compared 12-6
properties 4-34
purging 4-2, 4-12
read-only 13-6, 13-8, 13-15

at command-line 13-4
read-only at check-out 10-2
reasons for check-in 13-6
removing from version control 4-37
repairing database files 11-1
reports available 8-4
retaining locks at check-in 10-2
sending versions 7-4
sharing F-3
time stamps 2-23, 13-9
to be checked in 4-6
to be checked out 4-6
unlocked 4-4
unlocking 4-18

at command-line 13-4, 13-6,
13-8, 13-15

using keywords 4-26
validating database files 11-3
working 10-2
workstation database F-2

files list
Author 4-5
columns 4-4
controlling 4-4
defined A-6
Description 4-5
displaying 4-3
Exists 4-5
Ext 4-5
filters 4-6
group bands 2-5, 4-5
icons 4-4
Locker 4-5
Max Vers 4-5
Name 4-5
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Path 4-5
Size 4-5
sorting 4-5
Subproject 4-5
Time Stamp 4-5

files parameter
command-line 13-3

Files tab 4-3
filtering

audit log 6-4
defined A-6
files list 4-6
files to check in 13-6
files to check out 13-9

finding
differences in compared files 12-6
matches in compared files 12-6
text in compared files 12-5

fixing
project database files 11-1

fonts
charts 9-6, 9-10

forcing
a check-out

at command-line 13-9
omega storage

at command-line 13-5
formats

database F-2
Full Name

column in team list 5-2
G
gallery

changing chart data 9-7
changing chart types 9-5, 9-6

green
inserted text color 12-4

green light icon C-4
grids, charts 9-5

group
changing membership list 5-6

group bands
audit log 6-3
defined A-6
files list 2-5, 4-5
history list 4-13
team list 5-2

grouping
versions by label 4-2

groups
adding 5-4
adding members 5-6
charts available 9-3
deleting 5-9
deleting members 5-6

H
hiding

chart legends 9-5
hierarchies

projects 1-2
high

severity C-4
history list

Author 4-12
charts available 9-3
columns 4-12
defined A-6
disabled features 4-11
displaying 4-11
double-clicking 4-13
File Size 4-12
group bands 4-13
icons 4-12
menus 4-13
Reason for Check-In 4-12
reports available 8-4
sorting 4-12
Time Stamp 4-12
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Version # 4-12
History tab 4-11
horizontal

chart grids 9-5
I
icon

non-permanent 4-12
permanent 4-12

icons
files list 4-4
history list 4-12
projects 2-3
team list 5-2

importing
charts 9-4
projects from PVCS 14-1

improving
performance F-1

including
subdirectories

at command-line 13-3
Indicates 13-2
information

expanding keyword 4-26
Information icon

audit log 6-2
integration

StarTeam Workstation F-2
interface

command-line 13-1
introducing

security 1-6
StarTeam Workstation 1-1
version control 1-2

K
key, merged files 12-6
keyword expansion 2-13, 2-23, 2-24

defined A-6
keywords 4-26

defined A-6
files 4-26

L
labels

at check-in 4-2
build 4-2, 13-10
builds or milestones

at command-line 13-11
grouping versions 4-2
milestone 4-2
milestones

at command-line 13-10
not reusable 4-2
version 13-6, 13-9, 13-12, 13-14,

13-18
lck

command-line option 13-14
left panes 2-2
legends

editing charts 9-9
lights

severity C-4
locating

differences in compared files 12-6
matches in compared files 12-6
text in compared files 12-5

locked files 4-4
Locker

column in files list 4-5
lockers

broken lock message 7-1
defined A-7

locking
defined A-7
files 4-7, 4-18

at command-line 13-4, 13-6,
13-8, 13-14, 13-15

files on check-out 10-2
versions 1-5
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locks
retained at check-in 10-2

log
See audit log
viewing Project Maintenance log
 11-3

logging
information about Project Mainte-

nance 11-3
logging on F-3
low

severity C-4
M
mail

See e-mail
using 2-13, 2-23

mailing
See sending

managing
files 4-1
teams 5-1
users 5-1
versions 4-1

MAPI 7-1
defined A-7

mapping
working files to project hierarchy 1-3

matches
finding 12-6

Max Vers
column in files list 4-5

maximums
number of versions

at command-line 13-15, 13-16
numbers of versions 4-2

at command-line 13-5
versions 2-23

at command-line 13-5

medium
severity C-4

members
groups 5-6

memberships
users in groups 5-6

menus
audit log 6-3
history list 4-13
team list 5-2

merging
branched subprojects 3-19
compared files 12-6
defined A-7
file versions 4-8, 4-32
files

at command-line 13-16
messages

audit entries 7-5
broken locks 7-1
errors in command-line 13-3
reports attached 7-6
sending 7-1, 7-3
version attached 7-4
welcoming users 7-1

Microsoft Mail 7-1
milestones

checking out 4-29
defined A-7
designating

at command-line 13-11
labels 4-2

at command-line 13-10, 13-11
mnv

command-line option 13-15
modifying

See changing
moving

projects 2-24
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mrg
command-line option 13-16

N
Name

column in files list 4-5
NetBIOS over NetBEUI

defined A-8
non-permanent 4-2

defined A-8
icon 4-12
versions

at command-line 13-4, 13-6,
13-18

non-permanent versions
at command-line 13-18
setting maximums 2-13

NotePad 10-3
notes

See messages
numbers

maximum versions
at command-line 13-16

versions 13-9, 13-14, 13-18
numeric

defined A-8
O
omega storage 4-1, 13-16

at command-line 13-6
defined A-8
forcing

at command-line 13-5
maximum number of versions

at command-line 13-5
Only File Events

audit log 6-4
Only Project Events

audit log 6-4
Only Subproject Events

audit log 6-4

Only User Events
audit log 6-4

opening
projects C-1

opening, projects 2-15
options

charts 9-6
overriding 4-8
Visual Diff 12-8
workstation 4-7, 4-17, 10-1

order of
files in project tree 2-3
files in Visual Diff 12-4

overriding
workstation options 4-8

overview
security 1-6
StarTeam Workstation 1-1
version control 1-2

Owner
column in audit log 6-3
defects C-4

owners
defined A-8

P
packing

project database files 11-2
pallet bar

charts 9-8
password parameter

command-line 13-3
passwords

changing 5-8
Path

column in files list 4-5
pattern bar

charts 9-8
patterns

changing on charts 9-8
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performance
improving F-1

permanent 4-2
defined A-9
icon 4-12
versions

at command-line 13-4, 13-6,
13-18

permanent versions
at command-line 13-18
deleting

at command-line 13-14
pie charts

exploding 9-11
prg

command-line option 13-19
primary sort

defined A-11
printing

charts 9-5
compared files 12-6

Priority
column in defects list C-3

prm
command-line option 13-18

progress reports
at command-line 13-3

project
adding files 4-7, 4-14
files 4-6

project database file 2-6
command-line parameter 13-2

project database files
defined A-9
packing 11-2
repairing 11-1
validating 11-3

project files
defined A-9

Project Maintenance
log 11-3
starting 11-1

project trees
collapsing 2-3
defined A-9
drag-and-drop 2-3
expanding 2-3
explained 2-2
order of files 2-3
order of subprojects 2-3

project window
defined A-9

projects
advantages 2-1
backing up F-2
building 2-13, 2-19
creating 2-10
defaults 2-22
defaults for version control 2-13
defined A-9
deleting 2-25
excluding files from root subproject

2-14
hierarchy 1-2
icons 2-3
importing from PVCS 14-1
moving 2-24
opening 2-15, C-1
restored at start up 10-3
security 1-6
testing 2-13, 2-19
working files for 1-3

properties
files 4-34

purging
defined A-9
files 4-2, 4-12
versions 4-2, 4-12
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at command-line 13-19
PVCS, importing projects 14-1
R
rate

refresh 10-3
read-only files 13-6, 13-8, 13-15

at check-out 10-2
at command-line 13-4

Reason for Check-In
history list 4-12

reasons
for check-in 13-6

rebuilding
project database files 11-2

red
deleted text color 12-4

red light icon C-4
refresh

automatic 10-3
defined A-2

relocating
projects 2-24

removals
confirming 10-1

removing
chart patterns 9-8
projects 2-25
subprojects 2-25, 3-19
versions

at command-line 13-19
removing from version control

defined A-10
repairing

project database files 11-1
reports

available 8-4
creating 8-1
defining data for 8-1

progress
at command-line 13-3

sending 7-6
writing to file 8-5

responses
defined A-10

Responsibility
column in defects list C-4

restoring
projects 10-3

revisions
defined A-12
See versions

right panes
sorting 2-5

right-clicking 2-3, 5-2
defined A-10

rights
project level 2-8
subproject level 2-8

root projects
defined A-10

rotating
charts 9-5, 9-11

running
build commands 2-19, 3-15
project test commands 2-19
subproject test commands 3-15

S
saving

charts 9-4
reports as files 8-5

scope
changing 10-2

scope buttons 2-5, 10-2
defined A-10

searching
text 12-5
text in compared files 12-5
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secondary sort
defined A-11

security
adding groups 5-4
overview 1-6
project level 2-8
project-level 1-6
subproject level 2-8
subproject-level 1-6

sending
audit entries 7-5
e-mail messages 7-1
file versions 7-4
messages 7-3
messages automatically 7-1
reports 7-6

servers
defined A-11

setting
refresh rate 10-3
workstation options 4-17

settings
maximum non-permanent versions 2-

13
Severity

column in defects list C-4
sharing

files F-3
Show All

audit log 6-4
showing

chart legends 9-5
Size

column in files list 4-5
sorting

audit log 6-3
data in columns 2-5
defined A-11
files list 4-5

history list 4-12
team list 5-2

splash screen
displaying 10-3

splitter bar 12-2
splitting

subprojects 3-17
start up

restoring projects 10-3
StarTeam

upgrading to D-1
using with Versions 2.0 C-1

StarTeam Server D-2
StarTeam Web Connect D-2
StarTeam Workstation D-1

integration F-2
overview 1-1

starting
Project Maintenance 11-1

Status
column in defects list C-3

status bar
displaying 10-3

stcmd
add 13-4
ci 13-5
cmp 13-7
co 13-8
dbd 13-10
dms 13-11
dsc 13-12
dvr 13-13
lck 13-14
mnv 13-15
mrg 13-16
prg 13-19
prm 13-18

storage
ASCII files 4-1
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binary files 4-1
delta 4-1
omega 4-1, 13-6
text files 4-1

storing
data 2-6
information in database F-2
versions 4-1

structures
directories 3-2

subdirectories
including

at command-line 13-3
Subproject

column in files list 4-5
subproject 10-2
subprojects

at command-line 13-3
branching 3-17
building 3-5, 3-6, 3-14, 3-15
creating 3-4
defined A-11
deleting 2-25, 3-19
excluding files from subprojects 3-6,

3-16
merging branched 3-19
order in project trees 2-3
security 1-6
testing 3-5, 3-6, 3-14, 3-15
working files for 1-3

Suggestion icon
defects list C-4

swiveling
charts 9-11

Synopsis
column in defects list C-4

syntax
command-line 13-2

T
tab

changing 10-2
tabs

Audit Trail 6-2
team list

columns 5-2
defined A-11
disabled features 5-1
displaying 5-1
double-clicking 5-2
Full Name 5-2
group bands 5-2
icons 5-2
menus 5-2
reports available 8-4
sorting 5-2
User Name 5-2

team members
defined A-11
See users

teams
adding groups 5-4
adding users 5-3
charts available 9-3
managing 5-1

test commands
defined A-11

testing 2-13, 3-5, 3-6, 3-14
projects 2-19
subprojects 3-15

text
editing 10-3
searching compared files 12-5

text editor 10-3
text files

comparing 12-1
defined A-11
delta storage 4-1
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omega storage 4-1
three-dimensional charts 9-5, 9-10
tilting

charts 9-11
Time Stamp

column in audit log 6-2
column in files list 4-5
history list 4-12

time stamps 2-13
defined A-12
files 2-23
working files

at command-line 13-9
titles

editing charts 9-6, 9-10
toolbar

displaying 10-3
toolbars

chart window 9-4
tools

charts 9-6
two-dimensional charts 9-5, 9-10
Type

audit log 6-4
column in audit log 6-2
column in defects list C-4

types
charts 9-5, 9-6
storage 4-1

U
unlocked files 4-4
unlocking

defined A-12
files 4-18

at command-line 13-4, 13-6,
13-8, 13-14, 13-15

upgrading
Versions to StarTeam D-1

User
column in audit log 6-2

User Name
column in team list 5-2

user name
command-line parameter 13-3

User Type
team list 5-2

User=Me
audit log 6-4

users
adding 5-3
changing e-mail names 7-3
charts available 9-3
defined A-12
deleting 5-9
group memberships 5-6
managing 5-1
notified by e-mail 5-3
reports available 8-4
welcome messages 7-1

using
Versions 2.0 with StarTeam C-1

V
validating

project database files 11-3
vault files

compressing 2-13, 2-23
defined A-12

vaults
defined A-12

Version #
history list 4-12

version attributes
defined A-12

version control
defaults 2-13
defined A-12
overview 1-2
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version control system
defined A-13

version labels
defined A-13

version numbers
defined A-13

Versions
upgrading to StarTeam D-1
using with StarTeam 2.0 C-1

versions
charts available 9-3
checking in 4-8, 4-19
checking out 4-7

any version 4-24
most recent 4-22

comparing 4-30, 12-1
creating 1-5
date/time 13-9, 13-10, 13-12, 13-

18
defined A-12
deleting 4-36

at command-line 13-14
duplicate check in 13-6
grouping by label 4-2
information 4-26
keywords 4-26
labels 13-6, 13-9, 13-12, 13-14,

13-18
at command-line 13-4

managing 4-1
maximum numbers

at command-line 13-5, 13-15,
13-16

at file level 4-2
at project level 4-2

maximums 2-23
merging 4-8, 4-32
non-permanent

at command-line 13-18

numbers 13-9, 13-14, 13-18
order in Visual Diff 12-4
permanent

at command-line 13-4, 13-6,
13-18

purging 4-2, 4-12
reports available 8-4
sending 7-4
storing non-permanent 4-1
storing permanent 4-1

vertical
chart grids 9-5

viewing
charts 9-5, 9-10
defects C-2
Project Maintenance log 11-3

Visual Diff
changing color codes 12-4
comparing files or versions 12-1
default color codes 12-4
default colors 12-5
defined A-13
finding differences 12-6
finding matches 12-6
finding text in compared files 12-5
main window 12-2
merging files 12-6
options 12-8
order of files 12-4
splitting window 12-2

W
Warning icon

audit log 6-2
warnings

displaying 10-1
Web Connect D-2
windows

chart 9-4
Visual Diff 12-2
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Windows NotePad 10-3
word processor 10-3
working directories

creating 4-14
defaults 2-6, 3-2
defined A-13

working files
defined A-13
deleted at check-in 10-2
projects 1-3
subprojects 1-3
time stamps 2-13, 13-9

workstation database file F-2

workstation database files
defined A-14

workstation options 4-7, 10-1
defined A-14
overriding 4-8
setting 4-17
Visual Diff 12-8

writing
reports to files 8-5

Y
yellow light icon C-4
Z
z-cluster charts 9-5
zooming

charts 9-5
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